Instruction Manual
LHV2000 SERIES
Thank you for purchasing this product. Lorex is committed to providing our customers with a high quality, reliable security solution.

This manual refers to the following models:
LHV2104 (4-channel)
LHV2108 (8-channel)
LHV2116 (16-channel)
LHV2216 (16-channel)

For the latest online manual, downloads and product updates, and to learn about our complete line of accessory products, please visit our website at:

www.lorextechnology.com

WARNING
RISK OF ELECTRIC SHOCK DO NOT OPEN

WARNING: TO REDUCE THE RISK OF ELECTRIC SHOCK DO NOT REMOVE COVER, NO USER SERVICABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equilateral triangle, is intended to alert the user to the presence of uninsulated "dangerous voltage" within the product's enclosure that may be of sufficient magnitude to constitute a risk of electric shock.

The exclamation point within an equilateral triangle is intended to alert the user to the presence of important operating and maintenance (servicing) instructions in the literature accompanying the appliance.

WARNING: TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.

CAUTION: TO PREVENT ELECTRIC SHOCK, MATCH WIDE BLADE OF THE PLUG TO THE WIDE SLOT AND FULLY INSERT.
# Table of contents

1 Important Safeguards ................................................................. 1
   1.1 General Precautions ............................................................ 1
   1.2 Installation ........................................................................ 1
   1.3 Service .............................................................................. 3
   1.4 Use .................................................................................. 3
2 LHV2000 Series Features ............................................................. 4
3 Getting Started (LHV2000 Series) .................................................. 5
4 Front Panel (LHV2000 Series) ......................................................... 6
   4.1 LHV2104 / LHV2108 / LHV2116 ............................................ 6
   4.2 LHV2216 ........................................................................... 6
5 Rear Panel (LHV2000 Series) .......................................................... 8
6 Basic Setup (LHV2000 Series) ........................................................ 10
   6.1 Step 1: Connect the BNC Cameras ........................................... 10
   6.2 Step 2: Connect the Mouse .................................................... 10
   6.3 Step 3: Connect the Ethernet Cable ....................................... 10
   6.4 Step 4: Connect the Monitor ................................................ 11
   6.5 Step 5: Connect the Power Adapter and Power on the DVR ....... 11
   6.6 Step 6: Upgrade Firmware to Latest Version (if Available) ....... 11
   6.7 Step 7: Verify Camera Image ............................................... 12
   6.8 Step 8: Set the Time ............................................................ 12
   6.9 Default System Password & Port Numbers ............................ 12
      6.9.1 FLIR Cloud™ ............................................................... 12
   6.10 Quick Access to System Information ..................................... 13
   6.11 Connecting Cameras .......................................................... 13
      6.11.1 Camera Compatibility .................................................. 13
      6.11.2 About Lorex MPX Cameras ......................................... 13
      6.11.3 Installing Cameras ..................................................... 13
      6.11.4 Connecting Camera Extension Cables ......................... 14
      6.11.5 Extension Cable Options ............................................. 15
7 Mouse Control ............................................................................ 17
8 Remote Control ........................................................................... 18
   8.1 Setting the Remote Control Address ..................................... 19
9 Using the System ......................................................................... 20
   9.1 On-Screen Display .............................................................. 20
   9.2 Using the Quick Menu .......................................................... 21
   9.3 Adjusting Color Settings ....................................................... 21
   9.4 Using the Navigation Bar ...................................................... 22
   9.5 Using the Camera Toolbar ................................................... 23
      9.5.1 Using Quick Playback .................................................. 23
      9.5.2 Using Digital Zoom in Live Display ............................... 23
      9.5.3 Using Real-time Backup ............................................... 24
   9.6 Using the Virtual Keyboard ................................................ 24
10 Setting The Time ......................................................................... 25
11 Recording .................................................................................. 26
   11.1 Video Recording Types ....................................................... 26
   11.2 Main Stream and Sub Stream .............................................. 26
   11.3 Setting up Scheduled or Manual Recording ......................... 26
   11.4 Configuring Hard Drive Overwrite ...................................... 27
# Table of contents

12 **Search (Playback)** ................................................................. 28
   12.1 Playing Back Video from the Hard Drive .................................. 28
   12.2 Playback Controls ................................................................ 29
   12.3 Playing Back from a USB Drive .............................................. 29

13 **Backup** ............................................................................ 31
   13.1 Formatting the USB Thumb Drive ........................................... 31
   13.2 Backing up Video ................................................................. 32
   13.3 Using Video Clip Backup ..................................................... 32
   13.4 Viewing Backup Files ......................................................... 33
      13.4.1 Viewing Backup Files on PC ........................................... 33
      13.4.2 Viewing Backup Files on Mac ....................................... 36

14 **Managing Passwords and User Accounts** ............................. 39
   14.1 Changing Passwords ............................................................. 39
   14.2 Adding Users ..................................................................... 40
   14.3 Modifying Users ................................................................. 40
   14.4 Deleting Users .................................................................. 41
   14.5 Account Groups .................................................................. 41
   14.6 Adding Groups ................................................................... 41
   14.7 Modifying Groups ............................................................... 42
   14.8 Deleting Groups .................................................................. 42

15 **Using the Main Menu** ........................................................... 43
   15.1 Camera ............................................................................. 43
      15.1.1 Recording .................................................................... 43
      15.1.2 Configuring Recording Quality ....................................... 44
      15.1.3 Configuring Snapshot Recording Settings ......................... 45
      15.1.4 Creating Custom Channel Names .................................... 45
      15.1.5 Selecting Cable Type (Advanced) .................................... 46
   15.2 Info .................................................................................. 47
      15.2.1 HDD Info .................................................................... 47
      15.2.2 Record Info .................................................................. 47
      15.2.3 Version ....................................................................... 48
      15.2.4 Alarm Status ............................................................... 48
      15.2.5 Online Users ............................................................... 49
      15.2.6 Load .......................................................................... 49
      15.2.7 Test .......................................................................... 50
      15.2.8 BPS .......................................................................... 50
      15.2.9 Log .......................................................................... 50
   15.3 Setting .............................................................................. 52
      15.3.1 Network ...................................................................... 52
      15.3.2 Selecting DHCP or Static IP Address (TCP/IP) ............... 52
      15.3.3 Configuring System Ports (Connection) ......................... 53
      15.3.4 Configuring DDNS Settings ........................................... 53
      15.3.5 Configuring Email Alerts .............................................. 54
      15.3.6 Event ........................................................................ 55
      15.3.7 Configuring Motion Detection ....................................... 55
      15.3.8 Configuring Video Loss Settings ................................... 57
      15.3.9 Configuring Hard Drive Warnings ................................. 58
      15.3.10 Configuring Network Warnings .................................... 59
      15.3.11 Storage .................................................................... 59
      15.3.12 Configuring the Video Recording Schedule .................... 60
# Table of contents

18.1.2 Connecting to your System on iPhone ........................................ 103
18.1.3 Live View Interface ................................................................. 104
18.1.4 Controlling PTZ Cameras ......................................................... 105
18.1.5 Viewing Snapshots and Videos with Local Files .......................... 106
18.1.6 Using Playback Mode on iPhone .............................................. 107
18.1.7 Enabling Push Notifications .................................................... 108
18.1.8 Using the Event List ............................................................... 110
18.1.9 Using Favorites ................................................................. 111
18.1.10 Using the E-Map ................................................................. 112
18.1.11 Device Manager ............................................................... 114
18.1.12 Adding Devices Using an IP or DDNS Address (Advanced) ........... 115

18.2 iPad ............................................................................................. 117
18.2.1 Prerequisites ........................................................................ 117
18.2.2 Connecting to your System on an iPad ...................................... 117
18.2.3 Live View Interface ............................................................... 118
18.2.4 Controlling PTZ Cameras ......................................................... 119
18.2.5 Using Playback Mode on iPad .............................................. 120
18.2.6 Using Local File to View Manual Recordings ......................... 122
18.2.7 Enabling Push Notifications .................................................... 123
18.2.8 Using the Event List ............................................................... 125
18.2.9 Using Favorites ................................................................. 126
18.2.10 Using the E-Map ................................................................. 127
18.2.11 Using the Device Manager ..................................................... 129
18.2.12 Adding Devices Using an IP or DDNS Address (Advanced) ........... 129

18.3 Android ...................................................................................... 132
18.3.1 Prerequisites ........................................................................ 132
18.3.2 Connecting to your System on Android ..................................... 132
18.3.3 Live View Interface ............................................................... 133
18.3.4 Controlling PTZ Cameras ......................................................... 134
18.3.5 Viewing Snapshots and Videos with Local Files ....................... 135
18.3.6 Using Playback Mode on Android ........................................... 135
18.3.7 Enabling Push Notifications .................................................... 137
18.3.8 Using the Event List ............................................................... 138
18.3.9 Using Favorites ................................................................. 138
18.3.10 Using the E-Map ................................................................. 140
18.3.11 Device Manager ............................................................... 141
18.3.12 Adding Devices Using an IP or DDNS Address (Advanced) ........... 142

19 DDNS Setup (Advanced) .................................................................. 144
19.1 Accessing your System within a Local Network (LAN) .................... 144
19.1.1 Step 1 of 3: Connect your System to Your Router ....................... 144
19.1.2 Step 2 of 3: Obtain the System's Local IP Address ....................... 145
19.1.3 Step 3 of 3: Connect to the System's Local IP Address ................ 145

19.2 DDNS Setup—Access your System Remotely over the Internet ........... 147
19.2.1 Step 1 of 4: Port Forwarding ................................................... 148
19.2.2 Step 2 of 4: Create a DDNS Account ......................................... 148
19.2.3 Step 3 of 4: Enable DDNS on the System ................................. 152
# Table of contents

19.2.4 Step 4 of 4: Connect to the System’s DDNS Address ........... 152

20 LHV2000 Series Hard Drive Installation ........................................ 156
  20.1 Installing a Hard Drive ....................................................... 156
  20.1.1 LHV2104 / LHV2108 / LHV2116 .............................. 156
  20.1.2 LHV2216 ............................................................... 157
  20.2 Removing the Hard Drive .................................................. 159
  20.2.1 LHV2104 / LHV2108 / LHV2116 .............................. 159
  20.2.2 LHV2216 ............................................................... 160
  20.3 Formatting Hard Drives ..................................................... 161

21 Connecting a PTZ Camera (LHV2000 Series) .............................. 163
  21.1 Controlling a PTZ Camera (Local DVR) ............................... 164
  21.2 Advanced PTZ Controls ..................................................... 164
    21.2.1 Presets .............................................................. 165
    21.2.2 Tours .............................................................. 166
    21.2.3 Pattern ............................................................ 166
    21.2.4 Auto Scan .......................................................... 167

22 Recording Audio ........................................................................ 168
  22.1 Step 1 of 2: Connecting a Self-powered Microphone ................. 168
  22.2 Step 2 of 2: Configuring Audio Recording ............................... 168

23 Troubleshooting ........................................................................ 170

24 LHV2000 Series System Specifications ...................................... 172

25 Notices ................................................................................. 175
  25.1 FCC/IC Notice ................................................................. 175
  25.2 Modification ..................................................................... 175
  25.3 ROHS .............................................................................. 175
Important Safeguards

In addition to the careful attention devoted to quality standards in the manufacturing process of your product, safety is a major factor in the design of every instrument. However, safety is your responsibility too. This sheet lists important information that will help to ensure your enjoyment and proper use of the product and accessory equipment. Please read them carefully before operating and using your product.

1.1 General Precautions

1. All warnings and instructions in this manual should be followed.
2. Remove the plug from the outlet before cleaning. Do not use liquid aerosol detergents. Use a water-dampened cloth for cleaning.
3. Do not use this product in humid or wet places.
4. Keep enough space around the product for ventilation. Slots and openings in the storage cabinet should not be blocked.
5. It is highly recommended to connect the product to a surge protector to protect from damage caused by electrical surges. It is also recommended to connect the product to an uninterruptible power supply (UPS), which has an internal battery that will keep the product running in the event of a power outage.

CAUTION

Maintain electrical safety. Power line operated equipment or accessories connected to this product should bear the UL listing mark or CSA certification mark on the accessory itself and should not be modified so as to defeat the safety features. This will help avoid any potential hazard from electrical shock or fire. If in doubt, contact qualified service personnel.

1.2 Installation

1. Read and Follow Instructions - All the safety and operating instructions should be read before the product is operated. Follow all operating instructions.
2. Retain Instructions - The safety and operating instructions should be retained for future reference.
3. Heed Warnings - Comply with all warnings on the product and in the operating instructions.
4. Polarization - Do not defeat the safety purpose of the polarized or grounding-type plug.
   A polarized plug has two blades with one wider than the other.

   ![Polarized Plug]

   A grounding type plug has two blades and a third grounding prong.

   ![Grounding Plug]

   The wide blade or the third prong are provided for your safety.

   If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
5. **Power Sources** - This product should be operated only from the type of power source indicated on the marking label. If you are not sure of the type of power supplied to your location, consult your video dealer or local power company. For products intended to operate from battery power, or other sources, refer to the operating instructions.

6. **Overloading** - Do not overload wall outlets or extension cords as this can result in the risk of fire or electric shock. Overloaded AC outlets, extension cords, frayed power cords, damaged or cracked wire insulation, and broken plugs are dangerous. They may result in a shock or fire hazard. Periodically examine the cord, and if its appearance indicates damage or deteriorated insulation, have it replaced by your service technician.

7. **Power-Cord Protection** - Power supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them. Pay particular attention to cords at plugs, convenience receptacles, and the point where they exit from the product.

8. **Surge Protectors** - It is highly recommended that the product be connected to a surge protector. Doing so will protect the product from damage caused by power surges. Surge protectors should bear the UL listing mark or CSA certification mark.

9. **Uninterruptible Power Supplies (UPS)** - Because this product is designed for continuous, 24/7 operation, it is recommended that you connect the product to an uninterruptible power supply. An uninterruptible power supply has an internal battery that will keep the product running in the event of a power outage. Uninterruptible power supplies should bear the UL listing mark or CSA certification mark.

10. **Ventilation** - Slots and openings in the case are provided for ventilation to ensure reliable operation of the product and to protect it from overheating. These openings must not be blocked or covered. The openings should never be blocked by placing the product on a bed, sofa, rug, or other similar surface. This product should never be placed near or over a radiator or heat register. This product should not be placed in a built-in installation such as a bookcase or rack unless proper ventilation is provided and the product manufacturer’s instructions have been followed.

11. **Attachments** - Do not use attachments unless recommended by the product manufacturer as they may cause a hazard.

12. **Water and Moisture** - Do not use this product near water — for example, near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement, near a swimming pool and the like.

13. **Heat** - The product should be situated away from heat sources such as radiators, heat registers, stoves, or other products (including amplifiers) that produce heat.

14. **Accessories** - Do not place this product on an unstable cart, stand, tripod, or table. The product may fall, causing serious damage to the product. Use this product only with a cart, stand, tripod, bracket, or table recommended by the manufacturer or sold with the product. Any mounting of the product should follow the manufacturer’s instructions and use a mounting accessory recommended by the manufacturer.

15. **Camera Extension Cables** – Check the rating of your extension cable(s) to verify compliance with your local authority regulations prior to installation.

16. **Mounting** - The cameras provided with this system should be mounted only as instructed in this guide or the instructions that came with your cameras, using the provided mounting brackets.
17. **Camera Installation** - Cameras are not intended for submersion in water. Not all cameras can be installed outdoors. Check your camera environmental rating to confirm if they can be installed outdoors. When installing cameras outdoors, installation in a sheltered area is required.

### 1.3 Service

1. **Servicing** - Do not attempt to service this product yourself, as opening or removing covers may expose you to dangerous voltage or other hazards. Refer all servicing to qualified service personnel.

2. **Conditions Requiring Service** - Unplug this product from the wall outlet and refer servicing to qualified service personnel under the following conditions:
   - When the power supply cord or plug is damaged.
   - If liquid has been spilled or objects have fallen into the product.
   - If the product has been exposed to rain or water.
   - If the product has been dropped or the cabinet has been damaged
   - If the product does not operate normally by following the operating instructions. Adjust only those controls that are covered by the operating instructions. Improper adjustment of other controls may result in damage and will often require extensive work by a qualified technician to restore the product to its normal operation.
   - When the product exhibits a distinct change in performance. This indicates a need for service.

3. **Replacement Parts** - When replacement parts are required, have the service technician verify that the replacements used have the same safety characteristics as the original parts. Use of replacements specified by the product manufacturer can prevent fire, electric shock, or other hazards.

4. **Safety Check** - Upon completion of any service or repairs to this product, ask the service technician to perform safety checks recommended by the manufacturer to determine that the product is in safe operating condition.

### 1.4 Use

1. **Cleaning** - Unplug the product from the wall outlet before cleaning. Do not use liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning.

2. **Product and Cart Combination** - When product is installed on a cart, product and cart combination should be moved with care. Quick stops, excessive force, and uneven surfaces may cause the product and cart combination to overturn.

3. **Object and Liquid Entry** - Never push objects of any kind into this product through openings as they may touch dangerous voltage points or "short-out" parts that could result in a fire or electric shock. Never spill liquid of any kind on the product.

4. **Lightning** - For added protection of this product during a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the wall outlet and disconnect the antenna or cable system. This will prevent damage to the product due to lightning and power line surges.
LHV2000 Series Features

Features

- True 1080p recording on all cameras
- 24/7 security-grade hard drive
- Continuous, scheduled, and motion recording
- PTZ cameras supported, remote control through App
- H.264 video compression
- HDMI output (HDMI cable included) for simple connection to HDTVs
- Accurate time stamps with NTP & daylight savings time
- Click and drag digital zoom in live view and playback
- 2 video outputs (HDMI & VGA) to connect multiple monitors
- Instant USB backup of live video from selected camera
- Automatic firmware upgrade
- FLIR Cloud™ app with 3-Step setup
- PC and Mac compatible
- Instant mobile viewing on smartphones and tablets
- Advanced apps with live viewing, playback, video recording, and snapshot
- Motion push notifications and email alerts
- Dual streaming to conserve bandwidth

NOTE

1. Compatible with Lorex 1080p MPX, 720p HD cameras, or analog security cameras. For a list of compatible cameras, please visit www.lorextechnology.com/support.
2. Recording time may vary based on recording resolution & quality, lighting conditions and movement in the scene.
3. Requires a high speed internet connection and a router (not included). A minimum upload speed of 1Mbps is required for the best video performance. Up to 3 devices may connect to the system at the same time.
4. For the latest list of supported apps and devices, please visit www.lorextechnology.com/support.

Use product in accordance with the instructions provided. All trademarks belong to their respective owners. No claim is made to the exclusive right to use the trademarks listed, other than the trademarks owned by Lorex Corporation. We reserve the right to change models, configurations or specifications without notice or liability. Product may not be exactly as shown. Images are simulated.
Getting Started (LHV2000 Series)

The system comes with the following components:

- DVR (Digital Video Recorder)
- 12V DC power supply
- Remote control (may not be exactly as shown)
- USB mouse
- Ethernet cable
- HDMI cable
- Quick start guides

Hard drive size, number of channels, and camera configuration may vary by model. Please refer to your package for specific details. Check your package to confirm that you have received the complete system, including all components shown above.
4 Front Panel (LHV2000 Series)

4.1 LHV2104 / LHV2108 / LHV2116

1. **IR receiver and LED indicators**: IR receiver for the remote control. Keep the IR receiver clear from obstructions.
   - **NET**: Glows when network is in normal state. Turns off for network error.
   - **HDD**: Glows to indicate hard drive is in normal state. Turns off when there is a hard drive error.
   - **ALARM**: Not supported.
   - **PWR**: Glows to indicate the system is on.
2. **FN**: Performs special functions in some menus.
3. **ESC**: In menus, press to go back / exit menus. In playback, press to return to live view.
4. **Directional buttons**:
   - **↑**: From live view, press once to open the System Information screen. In menus, press to confirm menu options.
   - **Directional buttons**: Press to move cursor in menus. In live view, press up to change split screen layout; press left / right to select channels when single-channel mode is selected.
5. **USB port**: Connect a USB mouse (included) or connect a USB flash drive (not included) for data backup or firmware upgrades.
6. **Power button**: Press and hold to power off the system (system password required). Press to power the system back on.

4.2 LHV2216

1. **IR receiver and LED indicators**: IR receiver for the remote control. Keep the IR receiver clear from obstructions.
   - **Channel Indicators**: Glow when camera is connected to the corresponding channel.
   - **NET**: Glows when network is in normal state. Turns off for network error.
   - **HDD**: Glows to indicate hard drive is in normal state. Turns off when there is a hard drive error.
2. **Playback buttons:**
   - **Previous file**: Press to skip to the previous video file on the system.
   - **Next file**: Press to skip to the next video file on the system.
   - **Slow**: Press to slow playback / decrease playback speed.
   - **Fast**: Press to speed up playback / increase playback speed.
   - **Play backwards**: Press to play video backwards / pause video.
   - **Play**: Press to play video / pause video.

3. **SHIFT**: During text input, press to switch input types.
4. **REC**: Press to open manual recording controls.
5. **FN**: Performs special functions in some menus.
6. **ESC**: In menus, press to go back / exit menus. In playback, press to return to live view.

7. **Directional buttons:**
   - **⬅**: From live view, press once to open the System Information screen. In menus, press to confirm menu options.
   - **Directional buttons**: Press to move cursor in menus. In live view, press up to change split screen layout; press left / right to select channels when single-channel mode is selected.

8. **USB port**: Connect a USB mouse (included) or connect a USB thumb drive (not included) for data backup or firmware upgrades.
9. **Power button**: Press and hold to power off the system (system password required). Press to power the system back on.
Rear Panel (LHV2000 Series)

LHV2104 (4–Channel)

1. **On / Off switch**: Turns the DVR on or off.
2. **VGA**: Connect a VGA monitor (not included) to view the system interface.
3. **DC12V**: Connect the included AC power adapter.
4. **USB port(s)**: Connect a USB mouse (included) or USB flash drive (not included) for data backup or firmware updates.

**NOTE**

Lorex 1080p MPX and 720p wired HD PTZ cameras can accept commands directly via the video cable.

6. **HDMI**: Connect to an HDMI monitor or TV (not included) to view the system interface.
7. **LAN**: Connect a CAT 5 RJ45 Ethernet cable for local and remote connectivity.
8. **Audio IN/Audio OUT (RCA)**: Connect a self-powered microphone (not included) to the Audio IN port to record one channel of audio. Connect a speaker to the Audio OUT port. See 22 Recording Audio, page 168 for more details.

LHV2108 (8–Channel)

LHV2116 (16–Channel)

LHV2216 (16–Channel)
1. **On / Off switch**: Turns the DVR on or off.
2. **DC12V**: Connect the included AC power adapter.

**NOTE**

Lorex 1080p MPX and 720p HD PTZ cameras can accept commands directly via the video cable.

4. **LAN**: Connect a CAT 5 RJ45 Ethernet cable for local and remote connectivity.
5. **USB port(s)**: Connect a USB mouse (included) or USB flash drive (not included) for data backup or firmware updates.
6. **VGA**: Connect a VGA monitor (not included) to view the system interface.
7. **HDMI**: Connect to an HDMI monitor or TV (not included) to view the system interface.
8. **Audio IN/Audio OUT**: Connect a self-powered microphone (not included) to the Audio IN port to record one channel of audio. Connect a speaker to the Audio OUT port. See 22 Recording Audio, page 168 for more details.
6.1 Step 1: Connect the BNC Cameras

- Connect cameras to the **Video Input** ports on the rear panel of the DVR.

**NOTE**
Connect Lorex 1080p MPX, 720p HD, or analog cameras to the system. For a list of compatible cameras, please visit [www.lorextechnology.com/support](http://www.lorextechnology.com/support).

Push and twist the BNC connector clockwise to secure it to the BNC port.

6.2 Step 2: Connect the Mouse

- Connect a USB mouse (included) to one of the **USB** ports.

6.3 Step 3: Connect the Ethernet Cable

- Connect an Ethernet cable (included) to the **LAN** port on the rear panel of the DVR. Connect the other end of the Ethernet cable to a router on your network.
6.4 Step 4: Connect the Monitor

- Connect the included HDMI cable from the **HDMI** port to the TV or monitor (recommended).

  **OR**

- Connect a VGA cable (not included) from the **VGA** port to the monitor.

![Diagram showing HDMI and VGA ports]

1. VGA port.
2. HDMI port.

6.5 Step 5: Connect the Power Adapter and Power on the DVR

1. Connect the included power adapter to the **DC 12V** port. Connect the end of the power adapter to a wall socket or a surge protector.
2. Turn the power switch to **ON** to turn on the DVR.

![Diagram showing power switch]

At startup, the system performs a basic system check and runs an initial loading sequence. After a few moments, the system loads a live display view.

6.6 Step 6: Upgrade Firmware to Latest Version (if Available)

If a firmware upgrade is available, you will be asked to install it once the system starts up. It is required to upgrade your system firmware and client software or mobile apps to the latest version to enable remote connection to the system.

**If a firmware upgrade is available:**

1. After startup, a notification will appear asking you to upgrade the firmware. Click **OK** to upgrade.
2. Enter the system user name (default: admin) and password (default: 000000) and click **OK**. Wait for the firmware update to complete. The system will restart once the firmware has been upgraded.

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DO NOT POWER OFF THE SYSTEM OR DISCONNECT THE POWER CABLE DURING FIRMWARE INSTALLATION</strong></td>
</tr>
</tbody>
</table>

### 6.7 Step 7: Verify Camera Image

- Power on the cameras, and then verify the camera video quality before mounting the cameras to a permanent location.
- Mount the cameras under a sheltered location. Always verify the outdoor rating of your camera before installing it in a permanent location.

### 6.8 Step 8: Set the Time

- Set the system time and date for accurate video time stamps. Videos with inaccurate times may not be valid as surveillance evidence.
- For details on setting the system time, see 10 *Setting The Time*, page 25.

### 6.9 Default System Password & Port Numbers

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CAUTION</strong></td>
</tr>
</tbody>
</table>

The system requires a user name and password to log in to the system remotely using a computer or mobile device. After logging on remotely the first time, you will be asked to create a custom password for the system.

**Local system and remote connectivity (LAN & Internet) user name and password:**

- Username: admin
- Password: 000000

**Default ports for DDNS remote access:**

- Port 80 (HTTP port)
- Port 35000 (Client port)

#### 6.9.1 FLIR Cloud™

This system features the exclusive FLIR Cloud™. This is a cloud service that allows you to connect to your system over the Internet via a secure handshake with our servers. This means you can easily connect to your system without requiring any network configuration.

For details on setting up your system to connect to the Internet using FLIR Cloud™:

- See 16 *Connecting to Your System Over the Internet on PC or Mac*, page 72.
- OR
- See 18 *Connecting to your System Using Smartphone or Tablet Apps*, page 103.

Connectivity using Lorex's free DDNS service is also available, but requires the ports listed above to be port forwarded on your router.
6.10 Quick Access to System Information

To quickly open a window that displays vital system information:

- Right-click to open the Quick Menu and click **Info**. Enter the system user name (default: **admin**) and password (default: **000000**).
  
  **OR**

- Press the **button on the front panel.**
  
  **OR**

- Press the **ENTER** button on the remote control.

![System Info Screen](image)

**NOTE**
The QR code shown in the System Info screen can be scanned during mobile setup to enter the system's Device ID.

6.11 Connecting Cameras

6.11.1 Camera Compatibility

This system is compatible with 1080p MPX, 720p HD, and analog cameras. For a list of compatible cameras, please visit [www.lorextechnology.com/support](http://www.lorextechnology.com/support).

6.11.2 About Lorex MPX Cameras

Lorex MPX cameras transmit high-definition video over BNC cable (such as RG59). They use analog signals and can transmit video signals over long cable runs.

Lorex MPX cameras use a proprietary analog standard that only works with Lorex MPX DVRs. MPX is not compatible with HD-SDI equipment.

6.11.3 Installing Cameras

**CAUTION**
Cameras differ in terms of installation or mounting instructions. Please see the documentation that came with your camera(s) for specific installation instructions.

**Installation Tips**

- Test the cameras before permanent installation. Plan where you will route the wiring for the camera and where you will aim the camera.
- Mount the camera where the lens is away from direct and intense sunlight.
- Plan your cable wiring so that it does not interfere with power lines or telephone lines.
- Ensure that the camera wiring is not exposed or easily cut.
- Mount the camera in an area that is visible, but out of reach.
Basic Setup (LHV2000 Series)

- Avoid pointing the camera at a glass window to see outside. This may result in a bright white ring in the night vision image, as the light from the night vision LEDs may reflect off the glass.
- Adjust the camera angle so that it covers an area with high traffic.
- In "high-risk" locations, have multiple cameras point in the same area. This provides camera redundancy if a vandal attempts to damage the camera.

To install the cameras:

1. Mount the camera(s) to the desired mounting surface according to the instructions that came with the camera(s). Choose a firm mounting surface.

   **NOTE**

   If you wish to mount cameras to drywall, it is recommended to use drywall anchors (not included).

2. Adjust the camera stand to ensure that the camera has a satisfactory view of the area you would like to monitor. Stand configuration depends on the mounting surface you have chosen (see below for suggested stand configurations).

   ![Camera Mount Options](image)

   **NOTE**

   Camera model may not be exactly as shown.

6.11.4 Connecting Camera Extension Cables

**CAUTION**

The extension cable must be a single stretch of cable between the DVR and camera. You cannot connect multiple extension cables to each other. For more details on extension cables, see 6.11.5 Extension Cable Options, page 15.

1. Connect the male power connector on the BNC extension cable to the female power connector on the camera.
   - Connect the BNC connector to the camera.

2. Connect the female power connector on the BNC extension cable to the power adapter.

3. Connect the BNC connector to one of the Video Input ports on the rear panel of the DVR.

4. Plug the camera power adapter to a power outlet.
Camera Installation Diagram

1. Camera.
2. End of extension cable with male power connector.
3. Extension cable.
4. End of extension cable with female power connector.
5. Camera power adapter.
6. DVR.

6.11.4.1 Connecting and Removing BNC Cables

BNC (Bayonet Nut Connector) is a special connector that locks on to the system port and cannot be accidently removed.

To connect or remove a BNC connector:

- Push the BNC connector firmly into the BNC port and simultaneously twist the connector clockwise to tighten.
- To remove a BNC connector from a BNC port, push and simultaneously twist the connector counter-clockwise to loosen the BNC connector.

6.11.5 Extension Cable Options

You can extend the cable run for your camera depending on the cable type used. Additional extension cables sold separately. See table below:

<table>
<thead>
<tr>
<th>Option</th>
<th>Cable Type</th>
<th>Max Cable Run Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Lorex model MCBL-60BNCU BNC Cable</td>
<td>60ft / 18m</td>
</tr>
<tr>
<td>2</td>
<td>‘RG59’ or ‘Coax’ or ‘Coaxial BNC’ Siamese (Video and Power)</td>
<td>300ft / 92m</td>
</tr>
<tr>
<td>3</td>
<td>‘RG59’ or ‘Coax’ or ‘Coaxial BNC’ (Video Only)</td>
<td>800ft / 242m</td>
</tr>
</tbody>
</table>

CAUTION

The extension cable must be a single stretch of cable between the DVR and camera. You cannot connect multiple extension cables to each other.
NOTE

- For cable runs above 300ft / 92m (option 3), you must connect the power adapter directly to the camera, rather than at the end of the extension cable (see diagram below).

- Indicators that your cable run may be too long:
  - Video is permanently black & white (even during day time).
  - Video is unclear, soft, or distorted.

- For more information on extension cables, visit www.lorextechnology.com/support.
The mouse is the primary control device for the system. To connect a USB mouse:

- Connect a USB mouse to the USB port on the front or rear panel.

1. **Left-button:**
   - In live view, click to open the Navigation Bar. Right-click to close the navigation bar.
   - In live view, while in a split-screen display mode, double-click an individual channel to view it in full-screen. Double-click again to return to the split-screen display mode.
   - While navigating menus, click to open a menu option.

2. **Right-button:**
   - During live view, right-click anywhere on the screen to open the Quick Menu.
   - Within system menus, right-click to exit menus.

3. **Scroll wheel:** In live view, use the scroll wheel to zoom in/out.
Remote Control

1. **Power**: Press and hold to power off the system. Press to power on.

2. **Playback controls**:
   - **Pause/Play**: In live view, press to enter playback mode. Press to play/pause playback.
   - **Reverse**: Press to reverse playback/pause playback.
   - **Fast**: Press to increase playback speed.
   - **Next**: Press to skip to next video.
   - **Previous**: Press to skip to previous video.
   - **Slow**: Press for slow playback.

3. **Esc**: In menus, press to go back / exit menus. In playback, press to return to live view.

4. **Directional keys**:
   - **Enter**: Press once to open the System Information screen; press twice to open the Navigation Bar. Press to confirm menu selections.
     - Press to move the menu cursor.
     - Press to change menu options.

5. **Mult**: Press to switch between full-screen and split-screen layouts.

6. **Number keys**:
   - 1–0: In live view, press to open channels in full-screen.
   - In menus, press to input numbers or text input.
   - **Shift**: Press to change input types.

7. **Add**: Configure remote control address. See below for details.

8. **Rec**: Press to open manual record menu.

9. **Fn**: Press to perform special functions in some menus.
8.1 Setting the Remote Control Address

If you have more than one system, you can set up your remote control to pair with a specific system.

To set the remote control address:

1. Right-click and click Main Menu. Enter the system user name (default: admin) and password (default: 000000).

2. Click General > General.

3. Under Device No., enter the address number you would like to assign to the remote control.

4. Click OK.

5. Using the remote control, press Add. Then enter the address number and press Enter.
Using the System

Use the system’s graphical on-screen display to navigate menus and configure options and settings.

### 9.1 On-Screen Display

The system shows the following for all display views:

1. **Display area:**
   - Double-click on a channel to view in full-screen; double-click again to return to split screen.
   - Right-click to open the Quick Menu.
   - Left-click to open the Navigation Bar.
   - Move the mouse to the top of a channel to view the Camera Toolbar.
   - Click-and-drag cameras to rearrange the channel display. This does not affect the channels each camera is connected or recording to.

2. **Channel name**
3. **C**: Camera is continuously recording.
4. **M**: Motion has been detected.
5. **Date & time**: Current system date and time. For details on setting the date and time, see 10 *Setting The Time*, page 25.
9.2 Using the Quick Menu

The Quick menu gives you access to the system’s key functions. To access the Quick Menu, right-click the screen during live view.

The Quick Menu has the following options:

- **View**: Select a camera in full-screen or select a multi-channel display.
- **Pan/Tilt/Zoom**: Access controls for PTZ cameras (not included).
- **Color Setting**: Configure color settings for cameras.
- **Info**: Opens the system information window.
- **Sequence**: Click to start/stop sequence mode.
  - In sequence mode, the system will automatically cycle through connected cameras every few seconds.
  - A will appear to show that sequence mode is on.
  - Click the icon to pause sequence mode on the channel that is currently shown (icon changes to ). Click again to resume sequence mode.
  - Right-click and select Sequence to return to normal viewing mode.
- **Disable Beep**: Click to disable the current system beeping alarm.
- **Search**: Search/playback recorded video. See 12 Search (Playback), page 28.
- **Manual**: Open the Record menu to select manual recording options. See 11.3 Setting up Scheduled or Manual Recording, page 26.
- **Main Menu**: Open the Main Menu. See 15 Using the Main Menu, page 43.

9.3 Adjusting Color Settings

Use the Color Settings menu to adjust color settings for your cameras.

To adjust color settings:

1. Right-click on the channel you would like to configure and select Color Setting. Enter the system password if prompted.
2. Adjust the following color settings:

- Saturation
- Brightness
- Contrast
- Chroma (Tint)
- Sharpness

3. Click OK to save changes.

9.4 Using the Navigation Bar

The Navigation Bar gives quick access to certain functions and menus.

To open the Navigation bar:

- Left click on the screen to open the Navigation Bar. The Navigation Bar has the following options:

1. Main Menu.
2. Collapse.
3. Select display layout.
4. Sequence: Click to start/stop sequence mode.
5. PTZ: Click to open PTZ controls.
6. Camera: Click to open camera image settings.
7. Search: Search and playback recorded video. See 17.4 Playback, page 84.
9. Channel Info: Click to access status information about connected cameras.
10. Network: Configure network settings for your system. See 15.3.1 Network, page 52.
11. HDD Manager: Manage hard drives connected to the system. See 15.3.16 Formatting the Hard Drive, page 63.
12. USB Manager: Click to access options for connected USB thumb drives (not included). You can backup video, logs, or system configurations and install firmware upgrades.
13. System Upgrade: Check for firmware upgrades. The system must be connected to the Internet to check for or receive updates.
9.5 Using the Camera Toolbar

The Camera Toolbar is used to perform actions on a specific channel.

To access the Camera Toolbar:

- Move the mouse to the top of the channel display. The Camera Toolbar has the following options:

  1. Quick Playback.
  2. Digital Zoom.
  3. Real-time backup.
  4. Snapshot.
  5. Mute/Unmute.

9.5.1 Using Quick Playback

Quick Playback is used to playback the last 5–60 minutes of video from the selected channel. You can also access Quick Playback in split-screen mode, while still viewing live video from the other channels.

To use Quick Playback:

1. Move your mouse to the top of the channel display and click 🎥. By default, the system will begin playback from 5 minutes ago. You can increase this to up to 60 minutes using the Instant Playback setting in Main Menu>Setting>General.

2. Right-click to exit Quick Playback.

9.5.2 Using Digital Zoom in Live Display

1. Move your mouse to the top of the channel display and click 📸 to activate digital zoom. A check mark will appear in the icon to indicate digital zoom is activated.

2. Click and drag inside the channel to zoom in.
  - Click and drag to pan the zoom area.
  - Right-click to zoom out and select a new zoom area.
  - Click 📸 to disable digital zoom. Note that the channel will remain at the same zoom level until you right-click inside it.
### 9.5.3 Using Real-time Backup

Real-time backup allows you to save footage from the live display to a USB thumb drive (not included) or external hard drive (not included).

**To use Real-time Backup:**

1. Insert the USB thumb drive or external hard drive into one of the USB ports on the system.

2. Move your mouse to the top of the channel display and click to start Real-time Backup.

3. Click again to end Real-time Backup. The file is saved to your USB device.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the system prompts you to log in, you will need to click again to start Real-time Backup after logging in.</td>
</tr>
</tbody>
</table>

### 9.6 Using the Virtual Keyboard

The Virtual Keyboard is used to input text or numeric values in certain menus.

1. **Backspace.**
2. **Enter capital letters.**
3. **Confirm entry.**
Setting The Time

**CAUTION**

It is highly recommended to set the date and time when first setting up your system. Inaccurate time stamps may render your footage unusable for court evidence.

**To set the date and time:**

1. In the main viewing mode, right-click and click **Main Menu**.
2. Log in using the system user name (default: admin) and password (default: 000000).
3. Click and select **Setting**. Click **General** and select the **Date&Time** tab.
4. Under **System Time**, enter the current time and select your time zone. Then, click **OK**.
5. Check **DST** to enable auto Daylight Savings Time updates.
6. (Optional) Check **NTP** to sync your system with an Internet time server. Click **Manual Update** to instantly update the time.
7. Click **Apply** to save changes.

**NOTE**

- You can adjust the **Start Time** and **End Time** for Daylights Savings Time if the default settings do not match your region.
- Under **DST Type**, select **Day of Week** to set the start and end time based on a day and week (e.g. 2nd Sunday in March), or select **Date** to set the start and end time to a specific date.

- Your system must have a constant connection to the Internet to use NTP.
- (Advanced) You can enter a custom NTP server under **Server IP** and **Port**, and you can select how often the system will sync the time using **Interval**.
By default, the system is set to immediately record video from connected cameras continuously, 24 hours a day. You can customize the recording settings according to your needs.

11.1 Video Recording Types
The system supports the following recording types.

- **Recording—Continuous**: Normal, continuous recording. A icon is shown when recording is in progress.
- **Recording—Motion**: The system records when motion is detected by the camera. An icon is shown when motion is detected.

11.2 Main Stream and Sub Stream
The system employs two video recording streams, a Main Stream and a Sub Stream. Both Main Stream and Sub Stream recording are enabled by default.

The Main Stream records high quality video to your system's hard drive.

The Sub Stream records lower resolution video for efficient streaming to devices over the Internet. Sub Stream recording must be enabled to view video recordings on a computer or mobile device.

You can configure the video quality parameters for the Main Stream or Sub Stream. For details, see 15.1.2 Configuring Recording Quality, page 44.

11.3 Setting up Scheduled or Manual Recording
You can set the system to record based on a schedule or you can manually turn recording on and off. By default, the system is set to record on an always on recording schedule.

To configure the recording schedule, see 15.3.12 Configuring the Video Recording Schedule, page 60.

To select between scheduled and manual recording:

1. Right-click and then select Manual>Record.
2. Under **Main Stream**, select how the system will record the Main Stream for each channel.
   - **Schedule**: Main Stream Recording will follow the recording schedule.
   - **Manual**: The system will record the Main Stream continuously as long as this option is checked.
   - **Stop**: The system will not record the Main Stream for this channel. This option is not recommended.

3. Under **Sub Stream**, select how the system will record the Sub Stream for each channel.
   - **Schedule**: Sub Stream Recording will follow the recording schedule.
   - **Manual**: The system will record the Sub Stream continuously as long as this option is checked.
   - **Stop**: The system will not record the Sub Stream for this channel.

4. Under **Snapshot**, select **Enable** to enable snapshot recording on each channel. Or, select **Disable** to disable snapshot recording.

5. Click **OK** to save changes.

### 11.4 Configuring Hard Drive Overwrite

When the hard drive is full, the system will overwrite the oldest recordings by default. This is recommended, as it makes sure that your system will continue to record without any input from you. You can also set the system to stop recording once the hard drive is full.

**To configure hard drive overwrite:**

1. Right-click and select **Main Menu**. Click **Setting>General>General**.

2. Under **HDD Full**, select **Overwrite** for the system to overwrite the oldest recordings when the hard drive is full. Or, select **Stop Record** for the system to stop recording when the hard drive is full.

![Image of system settings](image.png)

3. Click **OK** to save changes.
Search mode is used to navigate and playback recorded video files on the system.

12.1 Playing Back Video from the Hard Drive

1. From live view, right-click and then click Search.
2. Log in using the system user name (default: admin) and password (default: 000000).
3. Configure the following:
   3.1. Use the calendar on the right to select the day to playback.
   3.2. Use the drop-down menus to select the channels you would like to playback.
   3.3. Click inside the video bar to select the playback time. The system will begin playing back at the selected time.

   ![Diagram of the software interface]

   1. Calendar
   2. Drop-down menus
   3. Video bar

   **NOTE**
   Click the display options to playback multiple channels simultaneously.

   3.3. Click inside the video bar to select the playback time. The system will begin playing back at the selected time.
12.2 Playback Controls

1. Select playback device.
2. Calendar: Select the day to playback.
3. Channel select: Select channels to playback.
4. Video clip backup: Select video clip start and end times.
5. Backup video clip: Click to save selected clip.
6. Playback Bar: Click inside the bar to select a playback time.
7. Zoom Playback Bar: Select scope of time bar.
8. Recording types: Click to show/hide recording types.
9. Speed up.
10. Slow.
11. Previous/next frame.
12. Play backward.
13. Stop.

12.3 Playing Back from a USB Drive

If you have video files saved to a USB thumb drive (not included) or external hard drive (not included), you can play them back using the system.

To play back from a USB drive:

1. Connect the USB thumb drive (not included) or USB external hard drive (not included) with video files on it into a USB port on the system.
2. From live view, right-click and click Search.
3. Log in using the system user name (default: admin) and password (default: 000000).
4. Click **From ReadWrite Hdd** and select **From IO Device**. Click **Browse** to open the USB drive and manually select the video file.

5. Double click the video file you would like to open.
Backup

Backup video files to external USB flash drive (not included) or self-powered USB external hard drive (not included).

NOTE
USB external hard drives must be formatted in the FAT32 file format to be used with the system.

13.1 Formatting the USB Thumb Drive
It is recommended to format your USB thumb drive (not included) before using it with the system.

CAUTION
Formatting the USB device will permanently erase all data.

To format a USB device:
1. Insert a USB thumb drive (not included) into one of the USB ports.
2. From live view, right-click and then select Main Menu. Login if prompted.
3. Click >Backup.
4. Select the USB device you would like to format under Device Name and click Browse.
5. Click Format. Click OK to confirm.
13.2 Backing up Video

1. Insert a USB thumb drive (not included) into one of the USB ports.
2. From live view, right-click and then select Main Menu. Login if prompted.
3. Click \(\rightarrow\)Backup.
4. Configure your search options:

- Select the USB device you would like to format under Device Name.
- **Type**: Select the recording type you would like to search for or select **All** to search all recording types.
- **Channel**: Select the channel you would like to search or select **All** to search all channels.
- **File Format**: Select **DAV** to save files to save files to .dav format. You can playback .dav files using the Lorex video player software from www.lorextechnology.com/support. Or, select **ASF** for .asf format. You can playback .asf files in VLC Media Player (free download from www.videolan.org) on PC or Mac.

![Backup Configuration Screen]

**NOTE**

VLC Media Player is a free software available from www.videolan.org. VLC Media Player is not supported by Lorex.

- **Start Time/End Time**: Select the start and end time for your search.
5. Click Add. A list of files that match your search criteria appears.
6. Check files you would like to backup and then click Backup. Wait for the backup to complete.

**NOTE**

HD video files saved on the system may take up a large amount of disk space. The size of video files selected and the amount of free space on your USB device is shown at the top of the screen.

13.3 Using Video Clip Backup

Video clip backup allows you to select a duration of video during playback mode and save it to a USB device (not included).

**To use Video Clip Backup:**

1. Insert a USB flash drive (not included) or USB external hard drive (not included) into one of the USB ports.
2. Start playing back video using the steps in 12.1 Playing Back Video from the Hard Drive, page 28.

3. Click to mark the beginning of the video clip. Click to mark the end of the video clip.

4. Click to open the Backup menu.

5. Configure the following:

5.1. Check the USB device where you would like to save the file.

5.2. Check the files you would like to backup.

5.3. Click Backup. Then click Start. Wait for the backup to complete before removing the USB flash drive.

13.4 Viewing Backup Files

To playback .dav backup video files, a Player is available for PC and Mac at www.lorextechnology.com/support.

13.4.1 Viewing Backup Files on PC

You can download Video Player for PC from www.lorextechnology.com/support.

To view backup video files using the Player on PC:

1. Download and install the Video Player for PC from www.lorextechnology.com/support.
2. Double click one of the files on the left to begin playback.

OR

Click to open a back up video file in another location.

3. Use the Player controls to control playback or select other files for playback.

**Video Player Controls**

1. **File List**: Double-click to open a file.
2. **Display Area:** Select the split-screen mode. Double-click a video file to expand. Click the controls inside the display area to do the following:

- ![Icon](image.png): View information about the video file.
- ![Icon](image.png): Start/stop a manual recording from the video file.
- ![Icon](image.png): Take a snapshot from the video file.
- ![Icon](image.png): Close the video file.

3. **Hide/show file list.**

4. **Playback controls:**

- ![Icon](image.png): Playback files in sequence.
- ![Icon](image.png): Synchronize playback times.
- ![Icon](image.png): Play/pause playback.
- ![Icon](image.png): Stop playback.
- ![Icon](image.png): Previous frame.
- ![Icon](image.png): Next frame.
- ![Icon](image.png): Playback speed.
- ![Icon](image.png): Volume control.

5. **Zoom Timeline.**

6. **Add Files:** Click to open back up video files.

7. **Digital Zoom:** Click to activate digital zoom mode. Click and drag in the video to zoom in. Right-click to unzoom.

8. **Drag:** When digital zoom is activated, click to activate drag mode. Then click and drag in the video to view different areas of the image.

9. **Full-screen:** Click to open the player in full screen. Press **ESC** to exit full screen.
10. **Config**: Click to open the configuration menu for the player. From here you can control the default file formats and save locations for snapshots and video files saved from the player.

![Smart Player Configuration Menu](image)

### 13.4.2 Viewing Backup Files on Mac

A Video Player for Mac is available from [www.lorextechnology.com/support](http://www.lorextechnology.com/support).

To view backup video files using the Player on Mac:

1. Download **Video Player for Mac** from [www.lorextechnology.com/support](http://www.lorextechnology.com/support).
2. Double click the downloaded file in Safari to extract the Smart Player app file.

![Downloaded File][image]

3. Drag the **Smart Player** app to your Desktop or Applications list. Double click **Smart Player** to open it.
4. Double click one of the files on the left to begin playback.

OR

Click to open a backup video file in another location.

5. Use the Player controls to control playback or select other files for playback.

**Video Player Controls**

1. **File List**: Double-click to open a file.
2. **Display Area:** Select the split-screen mode. Double-click a video file to expand. Click the controls inside the display area to do the following:
   - : View information about the video file.
   - : Take a snapshot from the video file.
   - : Close the video file.

3. **Hide/show file list.**

4. **Playback controls:**
   - : When a video file ends, this button lets you select if you want the video player to repeat the same file or play the next file.
   - : Play/pause playback.
   - : Stop playback.
   - : Previous file.
   - : Next file.
   - : Playback speed.
   - : Volume control.

5. **Zoom Timeline.**

6. **Add Files:** Click to open backup video files.

7. **Full-screen:** Click to open the player in full screen. Press ESC to exit full screen.

8. **Config:** Click to open the configuration menu for the player. From here you can control the default file formats and save locations for snapshots and control the aspect ratio.

9. **About:** Click to see version information for the Player software.
Managing Passwords and User Accounts

By default, the system user name is **admin** and the password is **000000**. Passwords are enabled by default and are required to access the Main Menu or connect to the system using a computer or mobile device. You will be prompted to create a custom password after you connect for the first time.

![NOTE]

If you forget the password to the system, contact technical support to have it reset.

The system includes the following default accounts:

- **admin**: The admin account has full access to the system, may configure all system settings, and can manage user accounts.
- **default**: The default account is a limited user account that may only view live video from the cameras.

For security reasons, it is essential that you change the password on your system. **By default, the system password is enabled.**

### 14.1 Changing Passwords

You can change the system password of the admin and user accounts from the Users menu.

**To modify an account password:**

1. From Live View, right-click and then select **Main Menu**.
2. If prompted, enter the system user name (default: **admin**) and password (default: **000000**).
3. Click and select **Setting**. Select **Account**.
4. Click next to the user account you would like to modify.
5. Check **Modify Password**.
6. Under **Old Password**, enter the account’s previous password.
7. Under **New Password**, enter a new 6 character password for the account. Repeat the new password under **Confirm Password**.
8. Click **OK** to save changes.
14.2 Adding Users

You can allow multiple users to log in to the system. When adding different users, you can assign what menus they have access to. For example, you may want your friend to monitor your system while you are away, while not giving full access to your system.

To add a user account:

1. From Live View, right-click and then select Main Menu.
2. If prompted, enter the system user name (default: admin) and password (default: 000000).
3. Click and select Setting. Select Account.
4. Click Add User.
5. Configure the following:
   - **User Name**: Enter a name for the user account.
   - **Password**: Enter a 6 character password for the user account. Enter the password again under Confirm Password.
   - **Memo (optional)**: Enter a description of the user account.
   - **Group**: Select the group you would like to assign to this user account. A user account cannot be given permissions its group does not have.
   - **Multiuser**: Check to enable this user account to be used to login from more than one device at the same time.
   - **Authority**: Check the permissions you would like the user account to have. Under the System tab, select the menus the user account may access. Under the Playback tab, select which channels the user account may access recorded video from. Under the Cover tab, select the channels the user account may view live video from.
   - **User MAC**: Not supported. Leave this field blank.
6. Click OK to save changes.

Now, you can log in to the system locally, or remotely using the user name and password you created. When logging into the system with a user account, the user will only have access to the menus you assigned.

14.3 Modifying Users

1. In the Account menu, click next to the user account you would like to modify.
2. Update the user’s account details as needed, and then click OK to save changes.
14.4 Deleting Users

1. In the Account menu, click `x` next to the user account you would like to delete.
2. Click OK to confirm.

**NOTE**
The admin and default user accounts cannot be deleted from the system.

14.5 Account Groups

Account groups can be used to easily manage permissions for multiple user accounts. User accounts can be given all the permissions of a group, but cannot be given permissions that the group does not have.

The system includes the following groups by default:

- **admin**: Accounts in the admin group are system administrators. They have full access to the system, may configure all system settings, and can manage user accounts.
- **user**: Accounts in the user group are normal users. They have limited access to system menus.

14.6 Adding Groups

1. From Live View, right-click and then select **Main Menu**.
2. If prompted, enter the system user name (default: admin) and password (default: 000000).
3. Click and select **Setting**.
4. Click **Account** and select the **Group** tab.
5. Click **Add Group**.
6. Configure the following:

- Under **Group Name**, enter a name for the group.
- Under **Memo**, enter an optional comment for this group.
- Under **Authority**, check the permissions that the group will have. User accounts assigned to this group can not be given any permissions the group does not have.

7. Click **OK** to save changes.

### 14.7 Modifying Groups

1. In the Group tab, click next to the group you would like to modify.
2. Update the group’s details as needed, and then click **OK** to save changes.

### 14.8 Deleting Groups

1. In the Account menu, click next to the user account you would like to delete.
2. Click **OK** to confirm.

---

**NOTE**

The admin and user groups cannot be deleted from the system.
Using the Main Menu

To open the Main Menu:

- **Using the Mouse**: Right-click and click **Main Menu**.

**NOTE**
The system password may be required to access the Main Menu. By default, the user name is **admin** and the password is **000000**.

1. **SEARCH**: Open Search/Playback mode. For details, see 12 **Search (Playback)**, page 28.
2. **BACKUP**: Export files to USB device. For details, see 13 **Backup**, page 31.
3. **CAMERA**: Configure image settings, recording parameters, and titles for your cameras.
4. **INFO**: View system information.
5. **SETTING**: Configure general system, schedule, network, recording, display, and motion settings. Restore system to factory defaults.
6. **SHUTDOWN**: Logout, restart, or shutdown the system.

### 15.1 Camera

The Camera menu allows you to configure image settings, recording parameters, and titles for your cameras.

**NOTE**
To change the image settings for your cameras, see 9.3 **Adjusting Color Settings**, page 21.

#### 15.1.1 Recording

The Recording menu allows you to set recording parameters for your cameras, such as the resolution and frame rate.
15.1.2 Configuring Recording Quality

The system employs two video recording streams, a Main Stream and a Sub Stream. The Main Stream records high quality video to your system's hard drive. The Sub Stream records lower resolution video for efficient streaming to devices over the Internet. You can customize the video quality settings for these streams according to your needs.

To configure recording quality:

1. From the Main Menu, click [Recording] and select [Recording>Recording].
2. Select the camera you would like to configure.
3. Configure the following settings. Settings for the Main Stream are in the left column. Settings for the Sub Stream are in the right column.

   • **Type**: For the Main Stream, you can set different recording quality settings for Continuous, MD (Motion Detect), and Alarm recording. Select the type of recording you would like to configure.
   
   • **Resolution**: Select the resolution the selected camera will be recorded at. Higher resolutions create a more detailed image, but take up more hard drive space to record and require more bandwidth to stream to connected computers or mobile devices.

      - Available resolutions for the Main Stream are: 1080P (1920x1080), 720p (1280x720), 960H (960x480 NTSC / 960x576 PAL), D1 (704x480 NTSC / 704x576 PAL), HD1 (352x480 NTSC / 352x576 PAL), 2CIF (704x240 NTSC / 704x288 PAL), and CIF (352x240 NTSC / 352x288 PAL).
      - Available resolutions for the Sub Stream are: D1 (704x480 NTSC / 704x576 PAL), CIF (352x240 NTSC / 352x288 PAL), and Q CIF (176x120 NTSC / 176x144 PAL).

   • **Frame Rate (FPS)**: Select the frame rate in Frames Per Second (FPS) that each stream will record at. A higher frame rate provides a smoother picture, but requires more storage and bandwidth.

   • **Bit Rate Type**: Select CBR (Constant Bit Rate) or VBR (Variable Bit Rate) to determine the bit rate type. If you select VBR, select the Quality from 1 (lowest) to 6 (highest).

   • **Bit Rate (Kbps)**: Select the bit rate for each recording stream. A higher bit rate results in a better image, but increases the amount of hard drive space or bandwidth required.

   ---

   **Note**: For instructions on recording audio, see 22 Recording Audio, page 168.
4. (Optional) Click the **Copy** button to copy recording settings to other channels.
5. Click **OK** to save changes.

### 15.1.3 Configuring Snapshot Recording Settings

The system can be set to record snapshot images when a camera detects motion. These snapshots can be viewed through the Search menu or can be attached to email alerts and push notifications. The Snapshot tab in the Recording menu controls the quality and recording parameters for each camera.

**NOTE**

In order to enable Snapshot recording, the following menu options must be configured:

- The Snapshot schedule must be enabled for times that you would like to save snapshots. See 15.3.14 *Configuring the Snapshot Schedule*, page 61.
- Snapshot recording must be enabled for motion detection in the Event menu. See 15.3.7 *Configuring Motion Detection*, page 55.

To configure snapshot recording settings:

1. From the Main Menu, click ![camera icon] and select **Recording>Snapshot**.
2. Under **Snap Number**, select the number of snapshots the system will take when the snapshot button is pressed.
3. Configure the following settings for snapshots saved automatically from motion detection or the snapshot schedule:

![Snapshot Recording Settings]

- **Channel**: Select the channel you would like to configure.
- **Mode**: Select **Timing** for the system to take snapshots according to the snapshot schedule (see 15.3.14 *Configuring the Snapshot Schedule*, page 61) Select **Trigger** for the system to take snapshots only when triggered by motion detection (snapshot must be enabled in the Motion Detect menu (see 15.3.7 *Configuring Motion Detection*, page 55).
- **Image Size**: Select the resolution for snapshots.
- **Image Quality**: Select the snapshot image quality between 1 (lowest) and 6 (highest)
- **Snapshot Frequency**: Select the number of snapshots (up to 6) the system will take each time.

4. Click **OK** to save changes.

### 15.1.4 Creating Custom Channel Names

You can assign custom names to your cameras. For example, you can name your cameras based on their location (e.g. hallway or front door).
To create custom channel names:

1. From the Main Menu, click and select Channel Name.

2. Enter a custom name for each channel.

3. Click OK to save changes.

15.1.5 Selecting Cable Type (Advanced)

The default settings in this menu should work well for almost all types of installations. This menu should only be used to troubleshoot issues with picture quality caused by cabling with a resistance higher than 10Ω per 100m (330ft). Select the UTP option for any channels having the issue. In all other installations, use the Coaxial setting. Click OK to save your changes.
15.2 Info

Info contains menus that show you system information.

15.2.1 HDD Info

The HDD Info sub-menu shows information related to the hard drives installed in the system, including capacity, status, and type.

To access the HDD Info menu:

- From the Main Menu, click and then click Info.

15.2.2 Record Info
The Record Info menu shows the start and end times of recordings saved on the hard drive.

**To access the Record Info menu:**

- From the Main Menu, click \(\text{Info} \rightarrow \text{Record Info}\).

### 15.2.3 Version

The Version sub-menu allows you to view information about the current firmware installed on the system.

**To access the Version menu:**

- From the Main Menu, click \(\text{Info} \rightarrow \text{Version}\).

### 15.2.4 Alarm Status

The Alarm Status menu shows you a display of system alarms. Activated alarms are highlighted in white. Additional info is shown, such as channels that are currently detecting motion.

The following alarms are shown in the Alarm Status menu:

- **No HDD:** No hard drive is detected.
- **Disk Error:** Hard drive error detected.
- **Disk Full:** Hard drive is full.
- **Net Disconnection:** System is not connected to the network.
- **IP Conflict:** More than one device on the network is using the same IP address.
- **MAC Conflict:** More than one device on the network is using the same MAC address.
- **Video Loss:** Shows disconnected channels.
- **Motion:** Shows channels with active motion alarms.
To access the Alarm Status menu:

- From the Main Menu, click 📞 and then select Alarm Status.

### 15.2.5 Online Users

The Online Users menu shows a list of users connected to the system using computers or mobile devices.

To access Online Users:

- From the Main Menu, click 📞 and then select Network.

### 15.2.6 Load

The Load menu shows you the network traffic your system is sending and receiving.

To access Load:

- From the Main Menu, click 📞 and then select Network>Load.
15.2.7 Test

The Test menu allows you to test if your system can connect to other devices over the LAN or Internet. You can enter the IP address of a device and click Test to determine if your system can connect to it.

To access Test:

• From the Main Menu, click and then select Network>Test.

15.2.8 BPS

The BPS sub-menu shows the bitrates of connected cameras. The bitrate is the amount of data the camera is sending to the system.

To access BPS:

• From the Main Menu, click and then select BPS.

15.2.9 Log

The Log sub-menu allows you to search for system logs.
To search for system logs:

1. From the Main Menu, click and then select Log.
2. Under Type, select the log type to search for.
3. Under Start Time and End Time, select the start and end time for your search.
4. Click Search.
5. (Optional) Click Backup to export logs to a USB flash drive connected to the system.
15.3 Setting
The Setting menu allows you to configure general system, schedule, network, recording, display, and motion settings. It also allows you to restore the system to factory defaults.

15.3.1 Network
The Network menu allows you to configure network parameters for your system.

15.3.2 Selecting DHCP or Static IP Address (TCP/IP)
The TCP/IP menu allows you to configure IP address settings.

To configure IP address settings:
1. From the Main Menu, click and then select Network>TCP/IP.
2. Under Mode, select DHCP (recommended) to let the system automatically obtain an IP address from the router or Static to assign a static IP address.
   
   If you select Static, configure the following:
   • IP Address: Enter the IP address you would like to assign to the system. Make sure that no other device on your network is using the same IP address.
   • Subnet Mask: Enter the subnet mask for your network.
   • Default Gateway: Enter the gateway address for your network.
   • Preferred DNS: Enter the address of your primary DNS server.
   • Alternate DNS: Enter the address of your secondary DNS server.
3. Click OK to save changes.
15.3.3 Configuring System Ports (Connection)

The Connection menu allows you to configure ports used by the system. Please note that port forwarding is not required to use FLIR Cloud™ or to connect using the apps.

If you are using DDNS connectivity, port forwarding is required for the HTTP Port (default: 80) and TCP (Client Port) (default: 35000).

To configure system ports:

1. From the Main Menu, click and then select **Network>Connection**.

2. Configure the ports as needed and click **OK** to save changes.

**NOTE**

Up to 3 devices may connect to the system at the same time.

15.3.4 Configuring DDNS Settings

Lorex DDNS is available as an optional connectivity option. Please see 19 **DDNS Setup (Advanced)**, page 144 for details.

The primary connectivity option uses FLIR Cloud™ to connect to your system over the Internet without requiring port forwarding or DDNS registration. For details, see 16 **Connecting to Your System Over the Internet on PC or Mac**, page 72.

To configure DDNS Settings:

1. Visit [http://www.lorexddns.net](http://www.lorexddns.net) and register for a DDNS account.

2. From the Main Menu, click and then select **Network>DDNS**.
3. Check **Enable**.
4. Under **Domain Name**, enter the Domain Name/URL Request your received in the email after registering for DDNS.
5. Under **User ID**, enter your DDNS User Name.
6. Under **Password**, enter your DDNS Device password.
7. Click **OK** to save your settings.

**NOTE**

Please allow 10~15 minutes for the DDNS servers to update with your new DDNS address before attempting to connect.

### 15.3.5 Configuring Email Alerts

You can configure the system to send out email alerts for motion detection or other events.

**NOTE**

To send out motion detection alerts, you must enable the Send Email option for motion detection on each camera you would to receive alerts from. For details, see 15.3.7 Configuring Motion Detection, page 55.

To configure Email Alerts:

1. From the Main Menu, click **Network>** and then select **Email**.

2. Check **Enable** to enable email notifications.

**If you want to use Lorex’s email server (recommended):**

1. Check **Lorex Mail** to use the Lorex email server to send out alarm notifications. This is the recommended setting.
2. Configure the following:
   • **Receiver**: Enter the email address that will receive alerts.
   • **Sender**: Enter the sender's email address.
   • **Subject**: Enter the subject line for the email alert.
   • **Attachment**: Check to include a jpg image attachment of the camera.

   **NOTE**
   You must enable the Snapshot option for motion detection on each camera you would to receive attachments. For details, see 15.3.7 Configuring Motion Detection, page 55.

   • **Event Interval**: Enter the interval between alert emails.
   • **Health Enable**: Check to enable health check emails. Health check emails will be sent periodically to ensure that the system is functioning normally.
   • **Interval**: Enter the interval in minutes for health check emails.

3. Click **Test** to send a test email.
4. Click **OK** to save settings.

If you want to use your own email server (advanced):
1. Configure the following:
   • **SMTP Server**: Enter the SMTP server address.
   • **Port**: Enter the port used by the SMTP server.
   • **Anonymous**: Check if your server supports anonymous log ins. Otherwise, leave this unchecked.
   • **User Name**: Enter the SMTP user name.
   • **Password**: Enter the SMTP password.
   • **Receiver**: Enter the email address that will receive alerts.
   • **Sender**: Enter the sender's email address.
   • **Subject**: Enter the subject line for the email alert.
   • **Attachment**: Check to include a jpg image attachment of the camera.

   **NOTE**
   You must enable the Snapshot option for motion detection on each camera you would to receive attachments. For details, see 15.3.7 Configuring Motion Detection, page 55.

   • **Encrypt Type**: Select **SSL** or **TLS** if your server uses encryption. Select **None** if your server does not use encryption.
   • **Event Interval**: Enter the interval between alert emails.
   • **Health Enable**: Check to enable health check emails. Health check emails will be sent periodically to ensure that the system is functioning normally.
   • **Interval**: Enter the interval in minutes for health check emails.

2. Click **Test** to send a test email.
3. Click **OK** to save settings.

### 15.3.6 Event

The Event menu allows you to configure settings for motion detection, video loss, and system warnings.

### 15.3.7 Configuring Motion Detection

Motion Detection events allow the system to mark footage that has motion. This allows you to quickly locate relevant footage through Search. You can also configure system...
responses to motion detection events, such as activating the system buzzer or sending an email alert.

To configure Motion Detection events:

1. From the Main Menu, click and then click Event>Motion>Motion Detect.
2. Under Channel, select the channel you would like to configure.
3. Check Enable to enable motion detection on the selected channel.
4. Click Setup next to Region to configure which areas of the image will be enabled for motion detection. A grid will appear on the monitor.

Motion Grid

- Areas enabled for motion detection are shown in color and areas that are disabled are transparent.
- Hover the mouse at the top of the screen to select which motion area you would like to configure. You can set up to 4 motion detection areas and customize the sensitivity and threshold for motion detection separately for each area between 0 (lowest) and 100 (highest).
- The Sensitivity determines how sensitive the camera is to motion. For example, if the sensitivity is high, small amounts of motion are more likely to trigger an event. It is recommended to select a Sensitivity between 30~70.
- The Threshold determines how much motion is required to trigger an event. If the amount of motion exceeds the threshold, an event occurs. It is recommended to select a Threshold between 10~50.
- Right-click when finished.
5. Under Anti-dither, enter the anti-dither time. After a motion event occurs and motion stops, if motion is detected within the anti-dither time, the system continues the motion event and includes the new motion within the first event, rather than creating a new motion event.

6. Under Post_REC, enter the time the system will record after a motion event occurs.

7. To configure a schedule when motion detection will be enabled on this channel, click Setup next to Period. Configure times when motion detection will be enabled. For example, you may want to disable motion detection during business hours and enable it outside of business hours. Click OK when finished.

8. Configure the following system actions when motion is detected:
   - **Show Message**: Check to enable an on-screen pop-up when one of your cameras detects motion. On-screen pop-up shows the channels an event occurred on and the type of event.
   - **Send Email**: Check to enable email alerts. You must configure email alerts before you will be able to receive them (see 15.3.5 Configuring Email Alerts, page 54).
   - **PTZ Activation**: If you have PTZ cameras, check to set up your PTZ cameras to move to a specified preset when the camera detects motion. Click Setup to select the PTZ cameras you want to activate and specify the preset point each one will move to.
   - **Record Channel**: Select the channels that will record when motion is detected on the selected channel.
   - **Buzzer**: Check to enable the system buzzer.
   - **Snapshot**: Check to save a snapshot when the camera detects motion.

9. Click OK to save changes.

**NOTE**

Click Test to view a live view of the camera and see which areas of the screen trigger for motion. Areas where motion is detected will change color.

15.3.8 Configuring Video Loss Settings

Video Loss occurs if the system loses connection to one of the cameras.

To configure Video Loss settings:

1. From the Main Menu, click and then click Event>Motion>Video Loss.
2. Under Channel, select the channel you would like to configure.
3. Check Enable to enable video loss events for the selected channel.
4. Configure the following to customize settings for video loss events:
   - **Period**: Click Setup to configure a schedule for video loss events. It is recommended to leave this on the default setting, so you can be alerted at any time one of your cameras loses video.
   - **Show Message**: Check to show a popup message on the monitor if one of your cameras loses video.
   - **Send Email**: Check to enable email alerts. You must configure email alerts before you will be able to receive them (see 15.3.5 Configuring Email Alerts, page 54).
   - **PTZ Activation**: If you have PTZ cameras, check to set up your PTZ cameras to move to a specified preset when video loss occurs. Click Setup to select the PTZ cameras you want to activate and specify the preset point each one will move to.
   - **Record Channel**: Click the checkbox to enable video recording when video loss occurs. You can then select the channels the system will record when video loss occurs on the currently selected channel.
   - **Post_REC**: Enter the number of seconds the system will record after video loss occurs.
   - **Snapshot**: Click the box to enable snapshot recording when video loss occurs. You can then select which channels will save snapshots when video loss occurs on the currently selected channel.
   - **Buzzer**: Check to enable the system buzzer when video loss occurs on the currently selected channel.
5. Click OK to save changes.

### 15.3.9 Configuring Hard Drive Warnings

Hard drive warnings will notify you if an issue is detected with the hard drive.

To configure hard drive warnings:

1. From the Main Menu, click ![Main Menu Icon] and then click Event>Warning>HDD.

2. Under Event Type, select the hard drive event you would like to configure.
   - **No Disk**: No hard drive detected.
   - **Disk Error**: A hard drive error has been detected.
   - **Disk Full**: The hard drive is full or almost full. You can enter the percentage of disk space remaining that will trigger a warning under Less Than (e.g. when less than 10% of the hard drive is empty, trigger a warning). Disk Full warnings will not occur if overwrite is enabled.
   - **All**: Configure warnings for all hard drive events.
3. Configure the responses the system will take when the selected event occurs:
   • **Show Message**: Show a popup message on the monitor.
   • **Send Email**: Check to enable email alerts. You must configure email alerts before you will be able to receive them (see 15.3.5 Configuring Email Alerts, page 54).
   • **Buzzer**: Check to activate the system buzzer.

4. Click **OK** to save changes.

### 15.3.10 Configuring Network Warnings

Network warnings will notify you if your system loses connection to the Internet or local network or if there is an issue on your network.

**To configure network warnings:**

1. From the Main Menu, click ![Main Menu Icon](image) and then click Event>Warning>Network.

2. Under **Event Type**, select the event type you would like to configure.
   • **Net Disconnection**: The system has lost connection to the network.
   • **IP Conflict**: More than one device on your network has the same IP address.
   • **MAC Conflict**: More than one device on your network has the same MAC address.
   • **All**: Configure responses for all network events.

3. Configure the following for the selected event type:
   • **Enable**: Check to enable the selected event type.
   • **Show Message**: Check to show a popup message when the selected event occurs.
   • **Send Email**: Check to enable email alerts. You must configure email alerts before you will be able to receive them (see 15.3.5 Configuring Email Alerts, page 54).
   • **Buzzer**: Check to activate the system buzzer.
   • **Record Channel**: If Net Disconnect is selected, you can set the system to trigger recording after it loses connection to the network. Check **Record Channel** to enable video recording and select the channels you would like to record. Set the amount of time you would like the system to record under **Post_REC**.

4. Click **OK** to save changes.

### 15.3.11 Storage

The Storage menu allows you to configure the recording schedule and hard drives connected to the system.
15.3.12 Configuring the Video Recording Schedule

You can set a custom recording schedule according to your needs. For example, you can set the system to record continuously during business hours and record on motion detection only outside of business hours.

A custom recording schedule helps reduce the amount of hard drive space required, increasing the time your system can retain recordings.

To configure the video recording schedule:

1. From the Main Menu, click and then click Storage>Schedule>Record.
2. Under Channel, select the channel you would like to configure or select All.
3. Configure the schedule as needed:
   
   - Check Continuous or MD (motion detection) to select the recording type you would like to configure.
   - Click and drag on each day to customize the recording schedule. The schedule is set up as a grid, which each block representing one hour.
   - Click next to All to link the recording schedules for all days. The icon for a day changes to when days are linked. You can also click the boxes next to individual days to link them to each other. If the recording schedule is linked, changes made to one of the days will apply to every day that is linked.
   - Click to disable all recording of the selected type on the selected day.
   - Click if you need to set a more precise schedule down to the minute.
4. Click OK to save changes.

15.3.13 Configuring Pre-Recording

The system can pre-record video when motion detection events occur.
To configure pre-recording:

1. From the Main Menu, click and then click **Storage>Schedule>Record**.

2. Under **Channel**, select the camera you would like to configure or select **All**.
3. Under **PreRecord**, select the duration for pre-recording.
4. Click **OK** to save settings.

### 15.3.14 Configuring the Snapshot Schedule

You can set a schedule for recording snapshots from the cameras.

To set up the snapshot schedule:

1. From the Main Menu, click and then click **Storage>Schedule>Snapshot**.

2. Under **Channel**, select the channel you would like to configure or select **All**.
3. Configure the schedule as needed:
   - Check **Continuous** or **MD** (motion detection) to select the recording type you would like to configure.
   - Click and drag on each day to customize the recording schedule. The schedule is set up as a grid, which each block representing one hour.
   - Click next to All to link the recording schedules for all days. The icon for a day changes to when it is linked. You can also click the boxes next to individual days to link them to each other. If the recording schedule is linked, changes made to one of the days will apply to every day that is linked.
   - Click to disable all recording of the selected type on the selected day.
   - Click if you need to set a more precise schedule down to the minute.

4. Click **OK** to save changes.

### 15.3.15 Configuring Holidays

You can set certain days as holidays. Holidays have a special recording schedule.

**To configure holidays:**

1. From the Main Menu, click and then click **Setting>General>Holiday.**

2. Click **Add New Holidays.**
3. Configure the following:

- **Holiday Name**: Enter a name for this holiday.
- **Repeat Mode**: Select *Once Only* for the holiday to occur only this year or *All-Year* for the holiday to be repeated each year.
- **Holiday Range**: Select *Date* to select a specific date, or select *Week* to select holidays based on which week they fall on.

4. Click *Add*. Now that you have added a holiday, an extra holiday setting is added to the recording schedule.

   ![Holiday Configuration Screen](image)

   **NOTE**

   You cannot delete holidays, but you can disable them by selecting *Stop* under the *Status* drop-down and then click *Apply*.

### 15.3.16 Formatting the Hard Drive

The HDD Manager menu allows you to format the hard drive. If you install a new hard drive, you must format the hard drive using the system before you will be able to record.

**To format the hard drive:**

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatting the hard drive erases <strong>all data</strong> on the hard drive. <strong>This step cannot be undone.</strong></td>
</tr>
</tbody>
</table>

1. From the Main Menu, click ![Main Menu](image) and then click *Storage>*HDD Manager.

2. Select the hard drive you would like to format and then click *Format*. Click *OK* to confirm.
3. Click OK to save changes. The system will restart to complete the formatting process.

### 15.3.17 Configuring Hard Drive Type

The system supports the following hard drive types:

- **Read-write HDD**: Normal recording hard drive.
- **Read-only HDD**: The system can playback data from this hard drive, but it will not record to it.

**To set the hard drive type:**

1. From the Main Menu, click \( \text{Click here} \) and then click **Storage>HDD Manager**.

2. Click the hard drive you would like to configure.
3. Under Type, select **Read-write HDD** or **Read-only HDD**.
4. Click OK to save changes. The system will restart to complete this operation.

### 15.3.18 Setting up Hard Drive Mirroring (LHV2216 Only)

A mirror hard drive can be used to automatically backup video footage recorded to the recording (read-write) hard drive. When a mirroring hard drive is installed, the system can be set to record cameras in parallel to both the recording hard drive and the mirror hard drive. This way, the footage is automatically backed up if the recording hard drive fails.

**How hard drive mirroring works:**

1. Security system.
2. Primary hard drive.
NOTE

- The mirror hard drive must be as large or larger than primary hard drive to backup all recordings.
- HDD mirroring begins from when mirror hard drive is installed and configured.
- Two hard drives must be installed in the system to use HDD mirroring. For details on installing hard drives, see 20 LHV2000 Series Hard Drive Installation, page 156.

To set up hard drive mirroring:

1. From the Main Menu, click and then click Storage>HDD Manager.
2. Click the Type drop-down under the second hard drive and select Mirroring HDD.

CAUTION

Setting a hard drive for mirroring erases all data on the hard drive. This step cannot be undone.

3. Click OK to apply changes. Click Yes to confirm. The system will format the hard drive and restart.

4. When the system restarts, click and then click Storage>Schedule>Record.

5. Under Channel, select the channel you would like to enable for mirror recording, then check Mirroring. Repeat the process for any additional channels.

6. Click OK to save changes.

15.3.19 Configuring General System Settings

You can use the General menu to configure miscellaneous system settings.
To configure general settings:

1. From the Main Menu, click and then click Setting>General>General.

2. Configure the following:
   - **Device Type**: Shows the model number of your system.
   - **Device No.**: Select the remote control address of the system. See 8.1 Setting the Remote Control Address, page 19.
   - **Language**: Set the system languages. Available options are English, French, and Spanish.
   - **Video Standard**: Select NTSC (North America) or PAL (Europe).
   - **HDD Full**: Select Overwrite for the system to overwrite the oldest recordings when the hard drive is full or select Stop Record for the system to stop recording when the hard drive is full.
   - **Pack Duration**: Select how the duration (in minutes) the system will store video files. For example, if this is set to 30 minutes, the system will create a new video file for each 30 minutes of continuous recording.
   - **Instant Playback**: Select the amount of time (in minutes) the system will go back when instant playback is activated in live view.
   - **Auto Logout**: Select the idle time (in minutes) before the system will logout the current user.
   - **Navigation Bar**: Check to enable the Navigation Bar that comes up when you left click in live view.
   - **Startup Wizard**: Check to enable a setup wizard when you start up the system.
   - **Mouse Speed**: Use the slider to adjust the mouse speed.

3. Click OK to save changes.

15.3.20 Setting the Monitor Resolution (Display)

The Display menu allows you to configure the systems monitor resolution and other display settings.
To set the monitor resolution:

1. From the Main Menu, click " — and then click Setting>Display>Display.

![Display settings menu]

2. Under Resolution, select the correct resolution for your monitor: 1920x1080, 1280x1024, 1280x720, or 1024x768.
3. Click OK to save changes. Click OK again to restart the system using the new resolution.

To configure other display settings:

1. From the Main Menu, click " — and then click Setting>Display>Display.

![Display settings menu]

2. Configure the following:
   - **Transparency**: Select the menu transparency.
   - **Time Display**: Check to show the time on the monitor.
   - **Channel Display**: Check to show the channel names on the monitor.
   - **Image Enhance**: Check for the system to digitally improve the video quality on the live display. This setting does not affect recordings.
3. Click OK to save changes.

15.3.21 Saving Your System Configuration to a USB Flash Drive

The system allows you to save your current system configuration to a USB flash drive (not included). This is useful if you want to backup your current settings.

NOTE

This function only saves settings created in system menus. It does not save or backup any video.
To save your system configuration to a USB flash drive:

1. Insert a USB flash drive (not included) into one of the USB ports.

2. From the Main Menu, click \(\text{Setting} > \text{Config Backup} \)

3. Under Device Name, select the USB device where you would like to save the configuration.

4. Click EXPORT to save your current system configuration.

To restore a saved system configuration:

1. Insert a USB flash drive (not included) with a saved system configuration into one of the USB ports.

2. From the Main Menu, click \(\text{Setting} > \text{Config Backup} \)

3. Under Device Name, select the USB device.

4. Click the folder with the configuration files you would like to restore. Configuration file folders are labeled “Config” and then the time and date the configuration was saved (e.g. Config_20140425103727).

5. Click IMPORT to restore the system configuration.

6. Click OK to confirm. The system will restart to complete the operation.

### 15.3.22 Setting the System to Factory Defaults

The Default menu allows you to reset the system to factory default settings.
To reset the system to factory default settings:

1. From the Main Menu, click \[\text{Setting}\] and then click \textit{Setting>Default}.

2. Check the menus you would like to reset to default settings.

3. Click \textbf{OK}.

\textbf{15.3.23 Upgrading Firmware from USB}

Firmware upgrades provide enhanced functionality. The system will automatically check for firmware upgrades if it is connected to the Internet. The system also supports firmware upgrades from a USB thumb drive (not included).

To upgrade firmware from a USB drive:

1. Download the firmware upgrade from \url{www.lorextechnology.com/support}.
2. Extract the firmware file and copy the firmware to a blank USB flash drive.

\begin{table}[ht]
\centering
\begin{tabular}{|l|}
\hline
\textbf{NOTE} \\
\hline
Do not have any folders on the USB flash drive—just the firmware file. \\
\hline
\end{tabular}
\end{table}

3. Insert the USB flash drive to a USB port on the system.

4. Right-click and then click \textbf{Main Menu}. Click \textit{Setting>Upgrade}.

5. Click \textbf{Start}.
6. Select the firmware file on the USB drive and click **Start**.

![WARNING]

**WARNING**

DO NOT POWER OFF THE SYSTEM OR DISCONNECT THE POWER CABLE DURING FIRMWARE INSTALLATION
15.4 Shutdown

Use the Shutdown menu to shutdown, restart, or log out of the system.

To access the Shutdown menu:

1. From live view, right-click and select Main Menu.
2. Enter the system User Name (default: admin) and Password (default: 000000) and click OK.
3. Click Shutdown.
4. Select one of the following:

   - Logout: Log out the account that is currently active.
   - Shutdown.
   - Restart.
Connecting to Your System Over the Internet on PC or Mac

This system features connectivity using the exclusive FLIR Cloud™. This cloud-enabled service allows for Internet connectivity without requiring any network configuration. Up to 3 devices may connect to the system at the same time.

### NOTE

- Except where noted, the PC and Mac instructions in this section are the same.
- For smartphone/tablet setup, see Connecting to your System Using Smartphone or Tablet Apps, page 103.
- For the latest list of supported apps and devices, visit www.lorextechnology.com/support.

#### 16.1 System Requirements

Your system must meet the system requirements below:

<table>
<thead>
<tr>
<th>Description</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Core 2 Duo 3.0GHz</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows™ 8/7/Vista</td>
</tr>
<tr>
<td></td>
<td>Mac OS X 10.7 and above</td>
</tr>
<tr>
<td>Memory</td>
<td>2GB</td>
</tr>
<tr>
<td>Video</td>
<td>512 MB of video memory and above</td>
</tr>
<tr>
<td>Network (LAN)</td>
<td>10/100 BaseT Network</td>
</tr>
<tr>
<td>Network (WAN)</td>
<td>1 Mbps upstream</td>
</tr>
<tr>
<td></td>
<td>High-speed Internet service is required to remotely connect to your system.</td>
</tr>
</tbody>
</table>

#### 16.2 Step 1 of 3: Connect your System to Your Router

1. Power off your system by disconnecting the power adapter.
2. Connect an Ethernet cable (included) to the LAN port on the rear panel of the system. Connect the other end of the Ethernet cable to an empty LAN port (usually numbered 1~4) on your router.
3. Reconnect the power adapter to power the system back on.

16.3 Step 2 of 3: Obtain the system’s Device ID

The Device ID is a unique code that allows your system to handshake with FLIR Cloud™ servers for a secure connection over the Internet.

To find the Device ID:

1. The Device ID is located on a sticker on the system.

2. Write down the Device ID of the system.

16.4 Step 3 of 3: Connect to the System Over the Internet

Follow the steps below to connect to the system over the Internet.

**NOTE**

Make sure to upgrade your system to the latest firmware version. You must have the latest firmware and client software to connect to the system over the Internet.

To connect to the system over the Internet:

1. Download and install the client software.
   - **PC Users**: Download and install the Client Software for PC from [www.lorextechnology.com/support](http://www.lorextechnology.com/support).
   - **Mac Users**: Download and install the Client Software for Mac from [www.lorextechnology.com/support](http://www.lorextechnology.com/support). Double click to extract the software. Then, drag the software to Applications.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon (دولة) from the desktop or Applications list.
3. Log into the Client Software using the Client Software user name (default: admin) and password (default: admin) and then click Login.

4. Click Add Device.

5. Enter the following:
5.1. **Device Name**: Choose a name for your system of your choice.

5.2. **Device ID**: Manually enter the Device ID printed on the label.

5.3. **Client Port**: Enter the Client Port (default: 35000).

5.4. **User Name**: Enter the system User Name (default: admin).

5.5. **Password**: Enter the system Password (default: 000000).

6. Click **Add**. If this is the first time you are connecting, you will be prompted to change the system password.

7. Enter a new 6 character password and click **OK**. This password will be used to connect to your system from now on.

8. Click **on** then **off**.
9. Click and drag **Default Group** to the display window to open your cameras in live view.

**Congratulations!** You can now connect over the Internet to view and playback video on your computer.
Using FLIR Cloud™ Client for PC or Mac

FLIR Cloud™ Client allows you to connect to multiple systems from a PC or Mac.

17.1 Home Page

The Home Page allows you to access all the tabs within the software. Each tab allows you to access different features.

To open tabs:

Click a tab from the Home Page to open it or click the button at the top of the screen from within any tab to open a new tab.

17.2 Live View

The Live View tab is where you can view live video from connected systems.

To view live video from a system:

1. Click and then click to create a Live View tab.

2. Click and drag a DVR, NVR, group, or individual camera to open live video. To access individual cameras, you can click + to expand groups or systems.
17.2.1 Live View Controls

1. **Live display**: Double-click to expand the area. Right-click to access additional options. Hold the mouse over the display area to access the camera toolbar.

**Camera toolbar:**

1.1. **Streaming quality**: Shows the bitrate and resolution for the stream, and shows if display is showing the Sub Stream or Main Stream.
1.2. **Manual recording**: Click to start/stop manual recording.
1.3. **Snapshot**: Click to save a snapshot.
1.4. **Mute/unmute**: Click to mute/unmute audio (audio camera required).
1.5. **Not supported**.
1.6. **Instant playback**: Plays back the most recently recorded video from the camera. By default, it will play back the last 5 minutes of recorded video from the camera.
1.7. **Digital zoom**: Click to enable digital zoom mode. Click and drag over the display area to zoom on the camera. Then click and drag to pan. Click the icon again to zoom out.
1.8. **Disconnect**.

1. **Split-screen mode**: Click to select split-screen layout.

2. **Aspect ratio**: Use the drop down menu to select the aspect ratio for the selected camera. **Original** uses the actual aspect ratio of the image. **Full-win** stretches the image to fill up the entire display area.
3. **Full-screen**: Click to open full-screen mode. Press **ESC** to exit full-screen mode.

4. **Save view**: Click to save the current display layout and open cameras as a view. Then enter a name for the view.

5. **Start/stop tour**: Click to start the tour. During the tour the client will cycle through all saved views every few seconds. Click again to stop the tour.

6. **PTZ Controls**: Controls for PTZ cameras (not included). See 17.3 *Controlling PTZ Cameras*, page 80 for details.

7. **View**: Click **View** to access view menu. Then double-click on a view to open it in the display area.

![View Menu](image)

8. **Devices**: Shows a list of groups, cameras, and systems connected to the client. Drag items to the display area to open live video. Right-click to view additional options.

### 17.2.2 Opening Live View in Multiple Monitors

If your computer has multiple monitors, you can open more than one Live View tab and move them to secondary monitors. This allows you to monitor cameras on multiple monitors at the same time.

**NOTE**

Using multiple monitors significantly increases the amount of computing resources necessary to run the application and may affect performance.

To open Live View in multiple monitors:

1. Click ![Create Live View](image) and then click ![Live View](image) to create a Live View tab.
2. Click and drag the tab outside of the client window to create a new window. You can drag the window to one of the secondary monitors.

Result

17.3 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them using the client.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>You must ensure the PTZ camera is properly connected to your system and your system is configured to detect it before you can control them using the client.</td>
</tr>
</tbody>
</table>

To control PTZ cameras:

- Click the display area with the PTZ cameras and use the on-screen PTZ controls.
PTZ controls:

1. **Open menu**: Click to open camera OSD menu controls. This feature may not be supported for all camera models.

2. **Move camera**: Click the arrows to move the camera.
   - Click to open dynamic zoom mode. Then click and drag in the video area to zoom in the camera on an area.

3. **Zoom +/-**: Click to zoom the camera in and out.
4. **Focus +/-**: Click to increase/decrease the focus.
5. **Iris +/-**: Click to increase/decrease the iris.
6. **Advanced**: Click to access advanced PTZ controls.

### 17.3.1 PTZ Presets

Presets will save a camera position for quick retrieval.

**To add presets:**

1. Click to open the Advanced controls. Select **Preset**.

2. Click .
3. Select the number of the preset you would like to add.

4. Move the camera to the desired position.

5. Click to save the current position as a preset.

To go to a saved preset:

1. Select the preset number from the list or click to go to the currently selected preset.

17.3.2 PTZ Tours

Tours will cycle through a set of presets.

To configure a PTZ tour:

1. Click to open the Advanced controls. Select Tour.

2. Click .

3. Under Cruise ID, select the number of the tour you would like to configure.

4. (Optional) Under Cruise Name, enter a name for the tour.
5. Use the chart to select which presets you would like to include in the tour and the order of presets.

- **Preset**: Select the preset number.
- **Time(s)**: Enter the time in seconds the camera will remain on the selected preset.
- **Operation**: Click to add a preset to the tour. Click to delete a preset from the tour.

6. Click **OK** to save changes.

**To run a PTZ tour:**

1. Select the tour number and click .

**17.3.3 PTZ Pattern**

Patterns automatically cycle the camera between two positions.

**To create a pattern:**

1. Click to open the Advanced controls. Select **Pattern**.
2. Select the number of the pattern you would like to set up.
3. Move the camera into the desired start position.
4. Click to start recording the pattern.
5. Move the camera to the desired end position. Then, click to stop recording the pattern.

**To run a pattern:**

1. Select the pattern number and click .
17.3.4 PTZ Scan
Scan automatically cycles between a left and right point.

To set up scan mode:

1. Click \(\text{Scan}^{1}\) to open the Advanced controls. Select Scan.

2. Move the camera to the desired left position and click \(\text{Scan}^{1}\).

3. Move the camera to the desired right position and click \(\text{Scan}^{1}\).

To run scan mode:

1. Click \(\text{Scan}^{1}\).

17.3.5 PTZ Pan
Pan makes the camera continuously pan 360°.

To run Pan mode:

1. Click \(\text{Pan}^{1}\) to open the Advanced controls. Select Pan.

2. Click \(\text{Pan}^{1}\).

17.4 Playback
You can use Playback mode to playback video saved on systems connected to the client.

To access Playback mode:

- Click \(\text{Playback}^{1}\) and then click \(\text{Playback}^{1}\) to create a Playback tab.
To playback video:

1. Check the channels you would like to play back from in the Device List.
2. Under **Type**, check the file types you would like to search for.
   - **All**: All recordings.
   - **General**: Continuous recordings.
   - **MD**: Motion recordings.
   - **Alarm**: Alarm recordings. Your system must support alarm devices (not included) to use this feature.
3. Under **Stream**, select **Main Stream** to search for Main Stream recordings (high quality) or **Sub Stream** to search for Sub Stream recordings (smaller file size).
4. Select the start time and end time for your search under **From** and **To**. You may not search more than 24 hours of video.
5. Click **Search**. Wait for the client to find video saved to the system.
6. Click inside the playback bar to start playback.
17.5 Playback Controls

1. **Display area**: Double-click to expand/return to split-screen mode. Hold the mouse over the display area to open the camera toolbar.

   ![Main Stream(1730.74 kb/s, 1280*720)](image)

   - **Snapshot**: Click to save a snapshot.
   - **Digital zoom**: Click to enable digital zoom mode. Then, click and drag to zoom in. Click and drag to pan the camera. Click again to zoom out.

2. **Event**: Click to view recordings based on a list of events and files.
3. **Record**: Click to view recordings on a timeline.
4. **Sync**: Click to sync playback between channels. This forces all channels to playback from the same time.
5. **Pause/play**
6. **Stop**
7. **Frame-by-frame**: Click to advance the video by a single frame.
8. **Playback speed**: Use the slider to adjust the playback speed.
9. **Mute**
10. **Volume**
11. **Split-screen**: Select split screen configuration.
12. **Full-screen**: Click to open playback in full-screen. Press ESC to exit full-screen.
13. **Timeline zoom**: Use the slider to zoom in/out on the timeline.
14. **Playback timeline**: Shows recordings from the selected channels on a timeline. Click inside the timeline to start playback or select a playback time. Each type of recordings is shown in a different color. Continuous recordings are green, motion recordings are yellow, and alarm recordings are red.
15. **Video clip**: Click to start a video clip. You can download video clips to your hard drive.
16. **Download list**: Click to see a list of files you have downloaded and the progress of files that are currently downloading.

17. **Search**: Search for video on the selected channels based on the search parameters you set.

18. **Device list**: Select the channels you would like to search or playback video from.

### 17.6 Downloading Video to your Computer Hard Drive

You can download video to your computer hard drive to save important events or share them. It is recommended to download video of important events as soon as possible to ensure they are not overwritten by new recordings.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PC Users</strong>: You may need to run FLIR Cloud™ Client as an administrator to download files to your hard drive.</td>
</tr>
</tbody>
</table>

To download video files:

1. Start playing back video using the steps in 17.4 *Playback*, page 84.

2. Click to start a video clip at the current playback time. Click to stop the video clip.

3. Configure the following save options:

   ![Download Options Dialog]

   - **Path**: Use the default save folder or click Browse to select a different folder.
   - **File Format**: Select Original Format to save to .dav format (requires the video player). Select AVI to save files to .avi format (can be played in VLC Media Player).

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Mac version only supports downloading video to .dav format.</td>
</tr>
</tbody>
</table>

- **Download Video Player**: Check to save a copy of the video player with the downloaded file.

4. Click OK to start the download. A status screen will pop up to show progress on downloaded files.
17.7 Alarm

The Alarm menu allows you to view a list of alarms received by the client software.

To access Alarms:

- Click ![Alarm icon] and then click ![Alarm icon].

Alarm menu overview:

1. **Number of alarms**: Shows the number of open alarms.
2. **Alarm list**: Shows the list of alarms and information on when they occurred and which systems and channels triggered them.
3. **Alarm Process**: You can close alarms by selecting one of the options and clicking **OK**.
4. **Options**: Check to enable the following:

- **Display Link Video**: Open live video to monitor alarms on a continuous basis.
- **Display Overlay Window**: Show the overlay controls. They allow you to enable/disable sound alerts and quickly jump back to the Alarm menu from another tab.
- **Pause Refresh**: Stop refreshing the live video in the video popup.

17.8 **Log**

The Log menu allows you to view logs for the client software or to view logs for connected systems.

**To access logs:**

- Click and then click .

**To view client logs:**

1. Click **Client Log** to view logs for the client software.

2. Configure the following:

- **Start Time/End Time**: Select the start and end times to search for logs.
- **Log Type**: Select the type of logs to search for.

3. Click **Search**.

**To view logs from connected systems:**
1. Click **Device Log** to view logs from connected systems.

![Device Log](image1)

2. Configure the following:
   - **Start Time/End Time**: Select the start and end times to search for logs.
   - **Log Type**: Select the type of logs to search for.
   - **Device Name**: Select the system you would like to view logs from.

3. Click **Search**.

### 17.9 E-map

E-Map allows you to place cameras over a still image. For example, you can use the E-Map to create a virtual map of your cameras over a floor plan of your home or business.

**To create an E-map:**

1. Click ![E-Map icon](image2) and then click ![Add Map icon](image3).
2. Click **Add Map**.

![Add Map](image3)
3. Configure the following:

- **Name**: Enter a name for your e-map of your choice.
- **Picture**: Click File and then select a .png, .bmp, or .jpg image on your computer to use as the e-map.
- **Describe (optional)**: Enter a text description of the e-map.

4. Click **Save**.
5. Click **Edit** to edit the e-map.

6. Click and drag cameras from the device list to place them on the map.

To open cameras from the e-map:

1. Click **View**.
2. Double-click cameras on the map to open live video.

17.10 Devices

The Devices menu is where you can manage systems connected to the client software.

To access the Devices menu:

- Click and then click .

Devices overview:

1. Devices Found: Shows systems that are connected to the same network as the computer where the client is installed. Once you connect to the system, it moves to the bottom of the screen.
2. Search: Refresh the list of systems connected to the network.
3. Add: Add checked systems to the client software.
4. Device list: Shows a list of systems connected to the client software, and shows which systems are online.
5. Add Device: Add a remote system using a Device ID or IP/DDNS address.
6. Delete: Delete the selected system.
7. Import: Import a list of systems from a saved .xml file.
8. Export: Export a list of currently connected systems to an .xml file. This is useful if you need to re-install the software or if you want to open the same list of systems on a different computer.
9. Delete: Delete system.
11. **Edit**: Edit the connection details for the system.

### 17.11 Device Config

The Device Config menu allows you to remotely configure settings for connected systems.

**To access the Device Config menu:**

- Click [ ] and then click [ ].
- Click on a system in the device list to see the settings available for that system and then configure settings as needed.

#### NOTE

The settings available depend on the model of system you have.

### 17.12 Alarm CFG

The Alarm CFG menu allows you to configure alarms for the client software. The client software will alert you by popping up live video and playing sound alerts.

#### NOTE

Alarm upload must be enabled on the system in order for it to send the alarm to the client software.

**To create alarms:**

1. Click [ ] and then click [ ].
2. Click **Add** to create a new alarm.
3. In the **Alarm sources** menu, you set up the parameters that trigger the alarm.

- Under **Alarm Type**, select the alarm type that will trigger an alarm. For example, you can select Motion Detect for the alarm to be triggered by motion.
- Select the systems or channels you would like to trigger an alarm. Continuing the example, if CAM 1 is selected, the alarm will be triggered if there is motion on CAM 1.
- Click **Next**.
4. In the **Alarm link** menu, you set up the responses to alarms. Select the channels that will pop up or alarm out devices (not included; not all systems support alarm out devices) that will be triggered by an alarm.

   For each channel selected, configure the following:

   - **Video**: Pop up a window with live video from the selected channel, like the one below.

   - **Record**: Record video from the selected channel.

   - **Preset**: If you select a PTZ camera, you can select the preset that will be activated when an alarm occurs.

   - **Stay Time**: Enter how many seconds the video window will stay open or record when an alarm occurs.

5. Click **Next**.
6. In the **Period** window, configure times the alarm will be activated.

7. Click **Confirm** to save the alarm.
To manage alarms:

1. **Export**: Export current list of alarms as an xml file.
2. **Import**: Import list of alarms.
3. **Delete**: Delete selected alarm.
4. **Add**: Add new alarm.
5. **Alarms**.
6. **On/off**: Click to enable/disable alarm.
7. **Delete**: Click to delete alarm.
8. **Edit**: Click to edit alarm settings.

### 17.13 Tour & Task

The Tour & Task menu is where you can set up custom views for the system. You can also set up tours, which sets the client to automatically cycle through views.

**To start a tour:**

- Click 🔄 in Live View to start a tour. The live view will automatically cycle through all views you have set up in the Tour & Task menu. Click again to stop the tour.

**To add views:**

1. Click 🆕 and then click 🆕.
2. Click + to create a new view.
3. Under **Name**, enter a name for your view.
4. Under **Stay Time**, enter the number of seconds the view will be shown before the client switches to the next view.
5. Select the split-screen mode you would like to use for the view and then click and drag channels to the empty grid areas to select channels to be shown in the view.

6. Click **Save** to save the view. Or click **Add More** to save the view and create another view.

### 17.14 Account

The Account menu is where you can set up user accounts and passwords for the client software. To simplify management, you can group user accounts according to role. A role determines the permissions an individual user account can have.

**To access the account menu:**

- Click ![Folder Icon] and then click ![User Icon].

### 17.14.1 Managing User Accounts

By default, the client software includes an admin account that has full access to all features of the software and all connected systems. You can add user accounts with customized levels of access.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The admin account cannot be deleted. The default user name for the admin account is <strong>admin</strong> and the default password is <strong>admin</strong>.</td>
</tr>
</tbody>
</table>
To create a user account:

1. Click Add.

2. Configure the following settings for the user account:
   - **User Name**: Enter a user name for the account.
   - **Role**: Select the role for the user account. By default, the user account gains all the permissions of the role selected, but you can deactivate permissions as needed.
   - **Password/Confirm Password**: Enter the password for the user account.
   - **Remarks (Optional)**: Enter a text description of the user account.
   - **User Rights**: Check the permissions that will apply to the user account. If you click on LiveView, Playback, and PTZ, you can select which channels the user account can access in the Channel List section.

3. Click Save to create the account.

To switch between user accounts:

- Click.

To modify a user account:

- Click next to the user account you would like to modify. Edit the user account details and click Save.
To delete a user account:

1. Click next to the user account you would like to delete. Click OK to confirm.

17.14.2 Managing Roles

Roles make it easier to manage user accounts by determining the permissions an individual user account can have. By default, a new user account is given all the permissions of the role they are assigned to.

To create a role:

1. Click the Role tab.
2. Click Add.

3. Configure the following settings for the role:

   - **Role Name**: Enter a name for the role.
   - **Remarks (Optional)**: Enter a text description of the role.
   - **Role Rights**: Check the permissions that will apply to user accounts assigned this role. If you click on LiveView, Playback, and PTZ, you can select which channels may be accessed in the Channel List section.

4. Click Save.

To modify a role:

- Click next to the role you would like to modify. Edit the role details and click Save.
To delete a user account:

1. Click next to the role you would like to delete. Click OK to confirm.

17.15 General

The General menu is where you can configure application settings for the client software.

To access the General menu:

- Click and then click .

17.15.1 Basic

The Basic menu contains general settings for the client software.

The Basic menu contains the following settings:

- **Log Saved Time**: Select the number of days you would like the client to save log entries.
- **Instant Playback Time**: Select the number of minutes the system will go back when you start an instant playback.
- **Network Capability**: Select the speed of your computer’s network connection.
- **Resume Live View State**: Check for the client to resume live view when it starts up. The live view will open to the last view that you had open.
- **Auto login application**: Check for the client to automatically login when it starts up without entering a user name or password.
- **Auto Login Windows**: Not supported.
- **Language**: Select the language for the client software.
- **Sync Time**: Check to have the client software sync time with your computer’s system time. Select the time the software will sync the time. Click Sync Now to manually sync the time.
- **Time Format**: Select 12-Hour or 24-Hour time format. You must close the client and restart it to apply this setting.

**NOTE**

Click Save to save setting changes.

17.15.2 File

The File menu allows you to select the folders where the client software will save downloaded video files and snapshots.
Using FLIR Cloud™ Client for PC or Mac

The File menu contains the following options:

- **Snapshot Path**: Click **Browse** to select the default folder to save snapshots.
- **Record Path**: Click **Browse** to select the default folder to save video recordings.
- **Config Path**: Click **Browse** to select the folder where the client will save software config files.

**NOTE**

Click **Save** to save setting changes.

**PC Users**: You may need to run the client software as admin to save files to enable snapshot or video recording.

17.15.3 **Alarm Prompt**

The Alarm Prompt menu allows you to configure audio alerts. The client will play audio alerts when events occur. You can replace the default sounds with any .wav file.

**NOTE**

You must configure alarms in the Alarm CFG menu before the client will play alarm sounds.

The Alarm Prompt menu has the following options:

- **Open Audio**: Check to enable audio alerts.
- **Loop**: Check to repeat audio alerts until acknowledged.
- **Camera Masking**: Select or preview the sound that will play for camera masking alarms.
• **Motion Detect**: Select or preview the sound that will play for motion detection.
• **Video Loss**: Select or preview the sound that will play for video loss alarms.
• **Disk Full**: Select or preview the sound that will play for disk full alarms.
• **Disk Error**: Select or preview the sound that will play for disk errors.
• **External**: Select or preview the sound that will play for external alarms (triggered by sensor devices, which may not be supported on all systems).

• **E-map flashes when alarm occurs**: If the camera has alarms enabled and is added to an e-map, a 🚨 appears on the e-map when an event occurs.

**NOTE**

Click **Save** to save changes.

### 17.15.4 Version

The Version menu shows you which version of the client software you are using. It is recommended to always run the latest version of the software from [www.lorextechnology.com/support](http://www.lorextechnology.com/support).
Connecting to your System Using Smartphone or Tablet Apps

The system is compatible with iPhone, iPad and Android devices.

<table>
<thead>
<tr>
<th>Platform</th>
<th>App Name</th>
<th>Get App From</th>
</tr>
</thead>
<tbody>
<tr>
<td>iPhone/iPad</td>
<td>FLIR Cloud™</td>
<td>Apple App Store</td>
</tr>
<tr>
<td>Android</td>
<td>FLIR Cloud™</td>
<td>Google Play Store</td>
</tr>
</tbody>
</table>

See [www.lorextechnology.com/support](http://www.lorextechnology.com/support) for the latest list of supported apps and devices.

18.1 iPhone

FLIR Cloud™ is an iPhone app that allows you to remotely view your system.

18.1.1 Prerequisites

- Connect your system to your router using an Ethernet cable (included).
- **Make sure to upgrade your system to the latest firmware version.** You must have the latest firmware and mobile apps to connect to the system over the Internet.

18.1.2 Connecting to your System on iPhone

1. Download FLIR Cloud™ for free from the App Store.
2. Tap on the FLIR Cloud™ icon (📱) to start the app.
3. Tap **Sign up** and enter your email address and password to create a new account.
4. Tap 📦 then +.
5. Configure the following:
5.1. Tap **Scan QR Code** and line up the QR code on the top of your system using the camera on your mobile device.

![QR Code Scan Example](image)

**OR**

Under **Device ID**, manually enter the Device ID printed on the label.

5.2. **Name**: Choose a name for your system of your choice.

5.3. **Client Port**: Enter the **Client Port** (default: **35000**).

5.4. **User Name**: Enter the system’s **User Name** (default: **admin**).

5.5. **Password**: Enter the system’s **Password** (default: **000000**).

6. Tap **Connect**. You will be prompted to change the system password.

7. Enter a new 6 character password and tap **OK**. This password will be used to log on to your system from now on.

8. The app opens in Live View and streams video from your cameras.

**18.1.3 Live View Interface**

You can use FLIR Cloud™ in portrait and landscape mode.
Connecting to your System Using Smartphone or Tablet Apps

Live View Overview

1. **Menu**: Tap to bring up the Menu.
2. **Display Area**: Double-tap to open a channel in full screen. Swipe left or right to select a different page of channels.
3. **Pages**: Shows the number of pages available and highlights the currently selected page.
4. **Split**: Select the split-screen layout.
5. **Snapshot**: Tap to take a snapshot from the currently selected channel.
6. **Control Bar**: Contains the following options. Swipe left or right to access more options.
   - **Quick Playback**: Tap to start/stop quick playback.
   - **PTZ Controls**: Open/close PTZ controls. PTZ camera required (not included).
   - **Streaming Quality**: Open/close streaming quality panel.
   - **Not supported.**
   - **Not supported.**
   - **Not supported.**
   - **Digital Zoom**: Tap to activate digital zoom mode. Pinch to zoom in/out.
   - **Color Settings**: Tap to access color controls for the currently selected camera.
7. **Manual record**: Tap to start/stop manual recording.
8. **Access Favorites.**
9. **Connect/disconnect all**: Connect to/disconnect from all previously added cameras.
10. **Device List**: Tap to open a list of devices. You can use the Device List to open multiple systems or cameras at once.

18.1.4 **Controlling PTZ Cameras**

If you have PTZ cameras (not included), you can control them from the app.

To control PTZ cameras:
1. Tap the display area the PTZ camera is connected to.
2. Tap 📲 to open PTZ controls.

PTZ Controls

1. **Live Display**: Swipe to move the camera. Pinch to zoom in/out.
2. **Focus**: Tap to show focus controls.
3. **Zoom**: Tap to show zoom controls.
4. **Iris**: Tap to show iris controls.
5. **Goto preset**: Tap to access preset controls. Then use the sliders to select a preset and then tap the checkmark to goto the preset.

**NOTE**

You must set presets for the camera using the system’s local menus before you can use this feature.

18.1.5  **Viewing Snapshots and Videos with Local Files**

If you have saved snapshots or videos using the app, you may open them with Local Files.

**To access Local Files:**

- Tap 📦 to access the Menu, and then tap **Local Files**.
1. **Menu**: Return to Menu.
2. **Files**: Tap to open files.
3. **File Type**: Tap the options to select video files or snapshots.
4. **Options**: Tap to delete or export files to your device’s local storage.

**NOTE**

Exported snapshots and video files are saved to the Photos app. Video files are saved to MP4 format.

### 18.1.6 Using Playback Mode on iPhone

You can access recorded video on your system using your iPhone.

**NOTE**

You must enable Sub Stream Recording to use playback mode on mobile devices.

**To use Playback Mode:**

1. Tap to access the Menu, and then tap **Playback**.
2. Tap + and select a channel to playback.
3. Select the date then the start and end times to playback.
4. Use the on-screen controls to control playback.

**Playback Controls**

![Playback Controls Diagram]

4.1. **Display Area**: Double-tap to open in full-screen.
4.2. **Play/pause**.
4.3. **Time Bar**: Tap inside the bar to fast forward or rewind.
4.4. **Previous**: Select previous video file.
4.5. **Next**: Select next video file.
4.6. **Snapshot**: Tap to take a snapshot from the selected camera.
4.7. **Stop All**: Stop playback on all channels.
4.8. **Not supported**.
4.9. **Manual Record**: Tap to start/stop recording to your mobile device's local storage.
4.10. **Fast**.
4.11. **Slow**.
4.12. **Time Range**: Tap to change the range of time shown in the time bar.
4.13. **Next frame**.

### 18.1.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device when one of your cameras detects motion. Once you have received a push notification, you can select it to open live video or a snapshot attachment from the camera that detected motion.
Connecting to your System Using Smartphone or Tablet Apps

NOTE
Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. Tap to access the Menu, and then tap Push Config.
2. Tap the system you would like to configure.
3. Tap **Motion Detect** and then check each channel you would like to receive push notifications from.

![Motion Detect screenshot]

4. Tap **** to save changes. You will now receive a notification when one of the selected cameras detect motion.

### 18.1.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push notifications.

**NOTE**

You must configure push notifications before you can use the Event List.

To access the Event List:

- Tap **** to access the Menu, and then tap **Event List**.
Event List Overview

1. **Events**: Shows the details of each motion detection event. Tap the event to view the video or snapshot.
2. **Delete All**: Tap to delete all events in the Event List.

   ![Event List Overview](image)

   **NOTE**

   To delete a single event, swipe it to the left and then tap **Delete**.

3. **View**: Tap to view the video or snapshot for the selected event.

**18.1.9 Using Favorites**

Favorites allows you to select a group of cameras as a favorite. You can then quickly bring up the group of cameras in Live View without having to individually select each camera.

**To use Favorites:**

1. Tap 📏 to access the Menu, and then tap **Favorites**.
2. Tap a group to configure an existing group.

   **NOTE**

   Tap 📏 to create a new group and then enter a name for the new group.

3. To add cameras to the group, tap 📏.
4. Select the cameras you would like to add to the group. Tap ☑️ to save changes.

To delete cameras that have been added to the group, select the group in the group list. Then, swipe left and tap Delete.

To open Favorites in Live View:

1. Tap ➤ to access the Menu, and then tap Live View.
2. Tap ➤, and then tap ➤ to open the group.

18.1.10 Using the E-Map

E-Map allows you to place cameras over a still image. For example, you can use the E-Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. Tap ➤ to access the Menu, and then tap E-Map.
2. Tap  

3. Select a .jpg image on your mobile device.

4. Press  and select a camera. Drag the camera on the screen to place it on the map. Repeat to add additional cameras.

5. Click  . Choose a name for your E-Map and then tap OK.

**To open cameras from an E-Map:**

1. Tap in Live View.
2. Select the E-Map in the Device List.

3. Tap the camera or cameras to select and then tap **Connect** to open the cameras.

18.1.11 **Device Manager**

You can use Device List to add, delete, or edit your systems.

**To access Device Manager:**

- Tap ‌ to access the Menu, and then tap **Device Manager**.

**To edit a system:**

1. Tap the system in Device Manager. Tap ‌.

2. Edit the connection details as needed.
3. Tap **Connect** to save changes and connect to the system.
To delete a system:
1. Tap the system you would like to delete.
2. Tap ✅. Tap OK to confirm.

18.1.12 Adding Devices Using an IP or DDNS Address (Advanced)
The app can connect directly to a device via the IP address or DDNS address as an optional advanced connectivity method or for systems that do not support FLIR Cloud™.

Prerequisites:
- The device you are connecting to must be connected to the Internet.
- You must port forward the HTTP Port (default: 80) and Client port (35000) on your router to the device's local IP address.
- To ensure connectivity, it is highly recommended to register for a free DDNS domain to use with your system.
- For more information on port forwarding and DDNS, visit www.lorextechnology.com/support.

To add a device using an IP or DDNS address:
1. Tap 📦 then +.
2. Configure the following:
   2.1. Tap Register Mode and select IP/Domain.
   2.2. Name: Choose a name for your system of your choice.
   2.3. Address: Enter the IP address or DDNS address of your system.
   2.4. Client Port: Enter the Client Port (default: 35000).
   2.5. User Name: Enter the system's User Name (default: admin).
2.6. **Password**: Enter the **system's Password** (default: 000000).

3. Tap **Connect**. You will be prompted to change the system password.
4. Enter a new **6 character password** and tap **OK**. This password will be used to log on to your system from now on.
5. The app opens in **Live View** and streams video from your cameras.
18.2 iPad

FLIR Cloud™ is an iPad app that allows you to remotely view your system.

18.2.1 Prerequisites

- Connect your system to your router using an Ethernet cable (included).
- **Make sure to upgrade your system to the latest firmware version.** You must have the latest firmware and mobile apps to connect to the system over the Internet.

**NOTE**

For the latest list of supported apps and devices, visit www.lorextechnology.com/support.

**NOTE**

The app will ask for permission to send push notifications and to access Photos. It will only send notifications if you enable motion-activated push notifications in the Push Config menu. It needs access to Photos to save snapshots and video flips to the local storage on your mobile device.

18.2.2 Connecting to your system on an iPad

1. Install FLIR Cloud™ for free from the App Store.
2. Tap on the FLIR Cloud™ icon ( ) to start the app.
3. Tap then .
4. Tap **Device Manager**.
5. Tap **Add**.

6. Configure the following:
Connecting to your System Using Smartphone or Tablet Apps

6.1. Tap **Start Scanning** and line up the QR code on the top of the system using the camera on your device.

OR

Under **Device ID**, manually enter the Device ID printed on the label.

6.2. **Name**: Choose a name for your system of your choice.

6.3. **Client Port**: Enter the Client Port (default: 35000).

6.4. **User Name**: Enter the system's User Name (default: admin).

6.5. **Password**: Enter the system's Password (default: 000000)

6.6. **Channel Amount**: Enter the number of channels your system has.

7. Tap **Start Live View**. You will be prompted to change the system password.

8. Enter a new 6 character password and tap **OK**. This password will be used to log on to your system from now on.

9. The app opens in Live View and streams video from all connected cameras.

18.2.3 **Live View Interface**

You can use FLIR Cloud™ in landscape or portrait mode.
Live View Overview

1. **Display area**: Double-tap to open camera in full screen.
2. **Favorites**: Slide to select favorites.
3. **Disconnect**: Disconnect from all open cameras.
4. **Add to favorites**: Add the current view to favorites.
5. **Snapshot**: Tap to take a snapshot from the currently selected channel.

6. **Change display view**.
7. **Not supported**.
8. **Manual record**: Tap to start/stop manual recording from this channel.
9. **Not supported**.
10. **Open menus**.
11. **Select different camera**.

**18.2.4 Controlling PTZ Cameras**

If you have PTZ cameras (not included), you can control them using the app.

**To control PTZ cameras**:

1. In Live View, tap the window the PTZ camera is connected to.
2. Slide the middle controls to the right to access PTZ controls.

PTZ Controls

1. Live display: Swipe to move the camera. Pinch to zoom in/out.
2. Direction buttons: Tap to move the camera.
3. Zoom: Tap to zoom the camera in/out.
4. Focus: Tap +/− to adjust the focus.
5. Iris: Tap +/- to adjust the iris.
6. PTZ/EPTZ: Tap to switch between PTZ and EPTZ mode. Use PTZ mode to control PTZ cameras. Use EPTZ mode to activate digital zoom mode on non-PTZ cameras.
7. Goto preset: Tap to goto a camera preset.

**NOTE**

You must set presets for the camera using the system’s local menus before you can use this feature.

18.2.5 Using Playback Mode on iPad

You can access recorded video on your system using your iPad.
To use Playback Mode:

1. From Live View tap \ and then .

2. In Portrait Mode: Tap +, select the start time and end time for your search, and select the camera you would like to playback.
   OR

   In Landscape Mode: Select the start time and end time for your search, and drag the camera you would like to playback to the display area.

3. Use the playback controls.
18.2.6 Using Local File to View Manual Recordings

You can view manual recordings saved to your mobile device using the Local File menu.

To view manual recordings:

1. From live view, tap \[\text{Live View} \] then \[\text{Local Files} \].
2. Tap \text{Local Files}. 

NOTE
Playback controls are only shown in portrait mode.
3. Tap a video file to open it.

To delete videos:
1. Tap **Edit**.
2. Select the videos you would like to delete and tap **Edit**.

### 18.2.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device when one of your cameras detects motion. Once you have received a push notification, you can select it to open video or an image from the camera that detected motion.
To enable Push Notifications:

1. From live view, tap ![icon] then ![icon].
2. Tap **Push Config**.
3. Tap the slider for the system you would like to configure.

**NOTE**

Your cameras must have motion detection activated to receive push notifications.
4. Tap **Motion Detect** then check each channel you would like to receive push notifications from.

5. Under **Type**, select **Playback** to attach a video file with each push notification. Or, select **Picture** to attach a still image of the camera that detected motion.

6. Tap **OK** to save changes. Whenever the selected cameras detect motion, you will receive a notification.

### 18.2.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push notifications.

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>You must configure push notifications before you can use the Event List.</td>
</tr>
</tbody>
</table>

To access the Event List:

1. From live view, tap 📀 then 📌.
18.2.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly bring up the group of cameras in Live View without having to individually select each camera.

To create favorites:

1. In Live View, tap 📢 to save the cameras that are currently open as a favorite.
2. Enter a name for the favorite and tap OK.

To open favorites in Live View:

• In Live View, slide the dial to cycle through favorites.

To edit favorites:

1. From live view, tap 📢 then 🛠.
2. Tap Favorites.
3. Tap the favorite you would like to edit.
4. Tap Edit.
5. Select the cameras you would like to include in the favorite and then tap Save.
18.2.10 Using the E-Map

E-Map allows you to place cameras over a still image. For example, you can use the E-Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. From live view, tap \[\text{E-Map}\] then \[\text{Add}\].
2. Tap Add.
3. Select a .jpg image file on your mobile device.
4. To edit the E-map:
4.1. **Select Image**: Select a different image file to use for your E-Map.

4.2. **Add Camera**: Tap + to select cameras to add to your E-Map. Then drag the camera to place it on the E-Map.

4.3. **Delete E-Map**.

5. When you are finished editing the E-Map, tap **Save** and enter a name for the E-Map to save changes.

**To open cameras using the E-Map:**

1. In live view, tap + on an empty display window and select the E-Map.
2. Tap a camera from the E-map to open.

18.2.11 Using the Device Manager

Device Manager allows you to manage your systems.

To access Device Manager:

1. From live view, tap then .
2. Tap Device Manager.

To delete a system:

1. Tap the system to select it.
2. Tap Tap Yes to confirm.

To modify a system:

1. Tap a system to select.
2. Tap the system again to open the edit screen.
3. Update the connection details as needed and then tap Start Live View.

18.2.12 Adding Devices Using an IP or DDNS Address (Advanced)

The app can connect directly to a device via the IP address or DDNS address as an optional advanced connectivity method or for systems that do not support FLIR Cloud™.

Prerequisites:
- The device you are connecting to must be connected to the Internet.
• You must port forward the HTTP Port (default: 80) and Client port (default: 35000) on your router to the device's local IP address.
• To ensure connectivity, it is highly recommended to register for a free DDNS domain to use with your system.
• For more information on port forwarding and DDNS, visit www.lorextechnology.com/support.

To add a device using an IP or DDNS address:
1. Install FLIR Cloud™ for free from the App Store.
2. Tap on the FLIR Cloud™ icon to start the app.
3. Tap then .
4. Tap Device Manager.
5. Tap Add.

6. Configure the following:

6.1. Tap Register Mode and select IP/Domain. Then tap New Device to return to the New Device screen.
6.2. Name: Choose a name for your system of your choice.
6.3. Address: Enter the DDNS or IP address of your device.
6.4. Client Port: Enter the Client Port (default: 35000).
6.5. User Name: Enter the system’s User Name (default: admin).
6.6. **Password**: Enter the system's Password (default: **000000**)
6.7. **Channel Amount**: Enter the number of channels your system has.

7. Tap **Start Live View**. You will be prompted to change the system password.
8. Enter a new **6 character password** and tap **OK**. This password will be used to log on to your system from now on.
9. The app opens in Live View and streams video from all connected cameras.
18.3 Android

FLIR Cloud™ allows you to remotely view your system on Android devices.

18.3.1 Prerequisites

- Connect your system to your router using an Ethernet cable (included).
- **Make sure to upgrade your system to the latest firmware version.** You must have the latest firmware and mobile apps to connect to the system over the Internet.

**NOTE**

For the latest list of supported apps and devices, visit [www.lorextechnology.com/support](http://www.lorextechnology.com/support).

18.3.2 Connecting to your System on Android

1. Download FLIR Cloud™ for free from the Google Play Store.

2. Tap on the FLIR Cloud™ icon ( ) to start the app.

3. Tap **Sign up** and enter your email address and password to create a new account.

4. Tap then +.

5. Configure the following:

**EXAMPLE**

1. **Scan QR Code**
2. Name: HD System
3. Device ID: lnw86142b6c
4. Username: admin
5. Password: ********

5.1. Tap **Scan QR Code** and line up the QR code on the top of your system using the camera on your mobile device.

**OR**

Under **Device ID**, manually enter the Device ID printed on the label.
5.2. **Name**: Choose a name for your system of your choice.
5.3. **Client Port**: Enter the **Client Port** (default: 35000).
5.4. **User Name**: Enter the **system's Username** (default: admin).
5.5. **Password**: Enter the **system's Password** (default: 000000).

6. Tap **Connect**. You will be prompted to change the system password.
7. Enter a new **6 character password** and tap **OK**. This password will be used to log on to your system from now on.

8. The app opens in Live View and streams video from your cameras.

### 18.3.3 Live View Interface

You can use FLIR Cloud™ in portrait and landscape mode.

**Live View Overview**

1. **Menu**: Tap to bring up the Menu.
2. **Display Area**: Double-tap to open a channel in full screen. Swipe left or right to select a different page of channels.
3. **Pages**: Shows the number of pages available and highlights the currently selected page.
4. **Split**: Select the split-screen layout.
5. **Snapshot**: Tap to take a snapshot from the currently selected channel.
6. **Control Bar**: Contains the following options. Swipe left or right to access more options.
6.1. **Quick Playback**: Tap to start/stop quick playback.
6.2. **PTZ Controls**: Open/close PTZ controls. PTZ camera required (not included).
6.3. **Streaming Quality**: Open/close streaming quality panel.
6.4. **Not supported.**
6.5. **Not supported.**
6.6. **Not supported.**
6.7. **Digital Zoom**: Tap to activate digital zoom mode. Pinch to zoom in/out.
6.8. **Color Settings**: Tap to access color controls for the currently selected camera.

7. **Manual record**: Tap to start/stop manual recording.
8. **Access Favorites**.
9. **Connect/disconnect all**: Connect to/disconnect from all previously added cameras.
10. **Device List**: Tap to open a list of devices. You can use the Device List to open multiple systems or cameras at once.

### 18.3.4 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them from the app.

**To control PTZ cameras:**

1. Tap the display area the PTZ camera is connected to.
2. Tap to open PTZ controls.

**PTZ Controls**

1. **Live Display**: Swipe to move the camera. Pinch to zoom in/out.
2. **Focus**: Tap to show focus controls.
3. **Zoom**: Tap to show zoom controls.
4. Iris: Tap to show iris controls.
5. Goto preset: Tap to access preset controls. Then use the sliders to select a preset and then tap the checkmark to goto the preset.

**NOTE**
You must set presets for the camera using the system’s local menus before you can use this feature.

### 18.3.5 Viewing Snapshots and Videos with Local Files

If you have saved snapshots or videos using the app, you may open them with Local Files.

**To access Local Files:**

- Tap \[\] to access the Menu, and then tap **Local Files**.

1. **Menu**: Return to Menu.
2. **Files**: Tap to open files.
3. **File Type**: Tap the options to select video files or snapshots.
4. **Options**: Tap to share, delete, or export files to your device’s local storage.

**NOTE**
Exported video files are saved to MP4 format in the folder `/snapshot/mp4/`, which you can access by connecting your Android device to a computer using a USB cable.

### 18.3.6 Using Playback Mode on Android

You can access recorded video on your system using your Android.

**NOTE**
You must enable Sub Stream Recording to use playback mode on mobile devices. For details on enabling Sub Stream Recording, see 11.3 Setting up Scheduled or Manual Recording, page 26.

**To use Playback Mode:**

1. Tap \[\] to access the Menu, and then tap **Playback**.
2. Tap + and select a channel to playback.

![Channel selection interface]

3. Select the date then the start and end times to playback.

4. Use the on-screen controls to control playback.

**Playback Controls**

2. *Play/pause*.
3. *Time Bar*: Tap inside the bar to fast forward or rewind.
4. *Previous*: Select previous video file.
5. *Next*: Select next video file.
6. *Snapshot*: Tap to take a snapshot from the selected camera.
7. *Stop All*: Stop playback on all channels.
8. *Not supported*.
9. *Manual Record*: Tap to start/stop recording to your mobile device’s local storage.
10. *Fast*.
11. *Slow*.
12. *Time Range*: Tap to change the range of time shown in the time bar.
13. *Next frame*. 
18.3.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device when one of your cameras detects motion. Once you have received a push notification, you can select it to open live video or a snapshot attachment from the camera that detected motion.

NOTE
Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. Tap to access the Menu, and then tap Push Config.
2. Tap the system you would like to configure.
Connecting to your System Using Smartphone or Tablet Apps

3. Tap **Motion Detect** and then check each channel you would like to receive push notifications from.

4. Under **Push type**, select **Video** to attach a video clip to each push notification. Or, select **Image** to attach an image to each push notification.

5. Tap ✅ to save changes. You will now receive a notification when one of the selected cameras detect motion.

### 18.3.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push notifications.

**NOTE**

You must configure push notifications before you can use the Event List.

To access the Event List:

- Tap 📊 to access the Menu, and then tap **Event List**.

**Event List Overview**

1. **Events**: Shows the details of each motion detection event. Long press an event to delete just that event.
2. **Delete All**: Tap to delete all events in the Event List.
3. **View**: Tap to view the video or snapshot for the selected event.

### 18.3.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly bring up the group of cameras in Live View without having to individually select each camera.

To use Favorites:
1. Tap  to access the Menu, and then tap Favorites.
2. Tap a group to configure an existing group.

**NOTE**
Tap  to create a new group and then enter a name for the new group.

3. To add cameras to the group, tap .
4. Select the cameras you would like to add to the group. Tap  to save changes.

**NOTE**
To delete cameras that have been added to the group, select the group in the group list. Then, press and hold to delete cameras from the group.

**To open Favorites in Live View:**
1. Tap  to access the Menu, and then tap Live View.
2. Tap , and then tap  to open the group.
18.3.10 Using the E-Map

E-Map allows you to place cameras over a still image. For example, you can use the E-Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. Tap \( \text{\button} \) to access the Menu, and then tap \( \text{E-Map} \).

2. Tap \( \text{\button} \).

3. Select a .jpg image on your mobile device.

4. Press \( \text{\button} \) and select a camera. Drag the camera on the screen to place it on the map. Repeat to add additional cameras.

5. Click \( \text{\button} \). Choose a name for your E-Map and then tap \( \text{OK} \).

To open cameras from an E-Map:

1. Tap \( \text{\button} \) in Live View.
2. Select the E-Map in the Device List.

3. Tap the camera or cameras to select and then tap **Connect** to open the cameras.

18.3.11 Device Manager

You can use Device List to add, delete, or edit your systems.

**To access Device Manager:**

• Tap 📞 to access the Menu, and then tap **Device Manager**.

**To edit a system:**

1. Tap the system in Device Manager. Tap ✎.

2. Edit the connection details as needed.

3. Tap **Connect** to save changes and connect to the system.
Connecting to your System Using Smartphone or Tablet Apps

To delete a system:
1. Tap the system you would like to delete.
2. Tap . Tap OK to confirm.

18.3.12 Adding Devices Using an IP or DDNS Address (Advanced)
The app can connect directly to a device via the IP address or DDNS address as an optional advanced connectivity method or for systems that do not support FLIR Cloud™.

Prerequisites:
- The device you are connecting to must be connected to the Internet.
- You must port forward the HTTP Port (default: 80) and Client port (default: 35000) on your router to the device’s local IP address.
- To ensure connectivity, it is highly recommended to register for a free DDNS domain to use with your system.
- For more information on port forwarding and DDNS, visit www.lorextechnology.com/support.

To add a device using an IP or DDNS address:
1. Tap then .
2. Configure the following:
   2.1. Tap Register Mode and select IP/Domain.
   2.2. Name: Choose a name for your system of your choice.
   2.3. Address: Enter the IP address or DDNS address of your device.
   2.4. Client Port: Enter the Client Port (default: 35000).
   2.5. Username: Enter the system’s User Name (default: admin).
2.6. **Password:** Enter the **system's Password** (default: 000000).

3. Tap **Connect.** You will be prompted to change the system password.

4. Enter a new 6 character password and tap **OK.** This password will be used to log on to your system from now on.

5. The app opens in Live View and streams video from your cameras.
Free DDNS service is available as an optional connectivity method to connect to your system over the Internet.

DDNS Service is not required to connect to your system, since the system supports FLIR Cloud™. For details on setting up your system using FLIR Cloud™, see 16 Connecting to Your System Over the Internet on PC or Mac, page 72.

### 19.1 Accessing your System within a Local Network (LAN)

You can connect to your system through using the Client Software through the local area network (LAN). It is recommended to confirm connectivity over a local network before setting up your system for DDNS connectivity.

#### 19.1.1 Step 1 of 3: Connect your System to Your Router

1. Power off your system by disconnecting the power adapter.
2. Connect an Ethernet cable (included) to the **LAN** port on the rear panel of the system. Connect the other end of the Ethernet cable to an empty LAN port (usually numbered 1~4) on your router.

**NOTE**
Except where noted, the instructions in this section are the same on PC or Mac.

**NOTE**
To complete the steps below, your computer must be on the same network as your system.
3. Reconnect the power adapter to power the system back on.

19.1.2 Step 2 of 3: Obtain the System’s Local IP Address

1. Right-click to open the Quick Menu and click **Info**. Enter the system user name (default: **admin**) and password (default: **000000**).

2. Write down the **IP Address** of the system.
   - A local IP looks something like this: 192.168.5.118.

19.1.3 Step 3 of 3: Connect to the System’s Local IP Address

Follow the steps below to confirm connectivity over a local network on a PC or Mac.

**To connect using the system’s local IP address:**

1. Download and install the client software.
   - **PC Users**: Download and install the **Client Software for PC** from [www.lorextechnology.com/support](http://www.lorextechnology.com/support).
   - **Mac Users**: Download and install the **Client Software for Mac** from [www.lorextechnology.com/support](http://www.lorextechnology.com/support). Double click to extract the software. Drag the software to **Applications**.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon (.guardian) from the desktop or Applications list.
3. Log into the Client Software using the Client Software user name (default: admin) and password (default: admin) and then click Login.

4. The client scans your LAN for connected systems. Check your system (a) and click Add (b).

5. Enter the password for your system (default: 000000) and click OK.

6. If this is the first time you are connecting, you will be prompted to change the system password.
7. Enter a new 6 character password and click OK. This password will be used to connect to your system from now on.

![Password Input](image)

8. Click ![Upload](image) then ![Upload](image).

9. Click and drag Default Group to the display window to open your cameras in live view.

![Camera Display](image)

Result

![Result Image](image)

19.2 DDNS Setup—Access your System Remotely over the Internet

Setting up DDNS connectivity allows you to view your system from any computer or compatible mobile device with Internet access.
To set up remote connectivity with your system, you must:

1. Port forward the HTTP port (default: 80) and Client port (default: 35000) on your router to your system’s IP address.
2. Create a DDNS account.
3. Enable DDNS on the system.
4. Test the remote connection by entering your DDNS address in the client software.

**19.2.1 Step 1 of 4: Port Forwarding**

You must port forward the HTTP port (default: 80) and Client port (default: 35000) on your router to your system’s IP address before you can remotely connect to your system. There are several methods to port forward your router:

- Use the Auto Port Forwarding Wizard (PC only) to port forward the required ports (see www.lorentechology.com for details). For instructions, see the Auto Port Forward Wizard manual on www.lorentechology.com.
- Manually port forward the required ports on your router to your system’s IP address by following your router manufacturer’s instructions. For more information on port forwarding, see the reference guides on www.lorentechology.com.

**NOTE**

If the above ports are not forwarded on your router, you will not be able to access your system remotely.

**19.2.2 Step 2 of 4: Create a DDNS Account**

Lorex offers a free DDNS service for use with your system. A DDNS account allows you to set up a web site address that points back to your local network. This allows you to connect to your system remotely. You must create a DDNS account in the same network as your system.

To setup your free Lorex DDNS account:

1. In your browser, go to http://www.lorexddns.net and click Step 1.

2. The My Lorex account login screen opens (if you are already logged in, skip to step 4). Create a new account or log into an existing account. To create a new account, fill in the required fields on the right and click Create Account.
3. Click **Warranties** to register your product for warranty.

![Warranties page]

**NOTE**

Warranty registration is required to register for DDNS.

4. The Warranty page opens. Click **Activate Warranty** to register your product for warranty.

5. Under **Your Address**, select an address or click **Enter a New Address** to create a new address. Fill in your address information and click **Create Address**.
6. Fill in the warranty registration form with your product and purchase details. Check the sticker underneath your system for the Product Model Number and Serial Number. You can also upload a scan, photo, or electronic copy of your receipt or bill of sale. Click **Save Warranty**.

![Warranty Registration Form]

7. A page pops up to prompt you to register your product for Lorex DDNS. Click **Set Up a New DDNS**.

![Remote Connectivity]

8. Configure the following:
8.1. **Product Warranty**: Select the product warranty you created in the previous steps.

8.2. **Device Name**: Enter a name for your device. You can enter your name, business name, or anything of your choice. This is used to identify this device in your list of activated DDNS accounts that appears anytime you visit the DDNS page.

8.3. **MAC Address**: Enter the MAC address of your Lorex product. To find the MAC address:
   - Right-click to open the Quick Menu and click *Info*. Enter the system user name (default: admin) and password (default: 000000).

8.4. **URL Request**: Enter the web site address that will be used to connect to your Lorex product. For example, if you enter tomsmith, the address to access your video will be http://www.tomsmith.lorexddns.net.

9. Click **Save** to register your product for DDNS. A confirmation email will be sent to the email address used to register for My Lorex. You will need this information to enable remote access to your system. Record your information below:

<table>
<thead>
<tr>
<th>Domain name/URL Request:</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDNS User Name:</td>
</tr>
<tr>
<td>Device DDNS password:</td>
</tr>
</tbody>
</table>
19.2.3  Step 3 of 4: Enable DDNS on the System

To enable DDNS in your System:

1. Right-click and click Main Menu. Enter the system password if prompted.

2. Click and then click Network>DDNS.

3. Check Enable.

4. Under Domain Name, enter the Domain Name/URL Request your received in the email after registering for DDNS.

5. Under User Name, enter your DDNS User Name.

6. Under Password, enter your DDNS Device password.

7. Click OK to save your settings.

**NOTE**

Please allow 10–15 minutes for the DDNS servers to update with your new DDNS address before attempting to connect.

19.2.4  Step 4 of 4: Connect to the System’s DDNS Address

**NOTE**

Please allow 10–15 minutes for the DDNS servers to update with your new DDNS address before attempting to connect.

To connect using the system’s DDNS address:

1. Download and install the client software on a remote computer.

   - **PC Users**: Download and install the Client Software for PC from www.lorextechnology.com/support.
   - **Mac Users**: Download and install the Client Software for Mac from www.lorextechnology.com/support. Double click to extract the software. Drag the software to Applications.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon from the desktop.
3. Log into the Client Software using the Client Software user name (default: admin) and password (default: admin) and then click Login.

4. Click Add Device.

5. Enter the following:
5.1. Check By IP/Domain to add a system using the DDNS address.

5.2. **Device Name**: Choose a name for your system of your choice.

5.3. **IP/DDNS Address**: Enter the Domain Name/URL Request you received in the email when you registered for DDNS followed by .lorexddns.net.

**NOTE**

For example, if your Domain Name/URL Request is tomsmith, enter tomsmith.lorexddns.net

5.4. **Client Port**: Enter the Client Port (default: 35000).

5.5. **User Name**: Enter the system User Name (default: admin).

5.6. **Password**: Enter the system Password (default: 000000).

6. Click **Add**. If this is the first time you are connecting, you will be prompted to change the system password.
7. Enter a new 6 character password and click **OK**. This password will be used to connect to your system from now on.

8. Click **start** then **stop**.

9. Click and drag **Default Group** to the display window to open your cameras in live view.

**Congratulations!** You can now connect over the Internet to view and playback video on your computer.
The system comes with a pre-installed 3.5" SATA hard drive. Depending on your model, you can install:

- **LHV2104 / LHV2108 / LHV2116**: You can replace the hard drive with one up to a maximum size of 4TB.
- **LHV2216**: You can replace the hard drive with two hard drives up to a maximum size of 4TB each.

### 20.1 Installing a Hard Drive

#### 20.1.1 LHV2104 / LHV2108 / LHV2116

**CAUTION**

Make sure that the system is OFF and the power adapter is disconnected before removing/installing the hard drive.

To install the hard drive:

1. Insert hard drive screws (4x) on the hard drive and tighten them half way.

2. Power off the system, and unplug all cabling from the system.
3. Remove the rear panel screws (4x) and side panel screws (1x on each side). Remove the cover.

4. Place the hard drive over the screw slots on the bottom of the system and then slide the hard drive into place. The SATA connectors on the hard drive should face the right side of the unit if looking at it from the rear.
5. Connect the SATA power and data cable to the hard drive.

6. Turn the system over carefully. Tighten the hard drive screws (4x) to secure the hard drive.

   **CAUTION**

   Hold the hard drive in place when turning the system over to prevent damage to the system.

7. Replace the cover and cover screws (6x).

   **NOTE**

   After installation, you must format the hard drive in order to use it with the system. See 20.3 Formatting Hard Drives, page 161.

20.1.2 LHV2216

   **CAUTION**

   Make sure that the system is OFF and the power adapter is disconnected before removing/installing the hard drive.

**To install the hard drive:**

1. Insert hard drive screws (4x) on the hard drive and tighten them half way.

2. Power off the system, and unplug all cabling from the system.
3. Remove the rear panel screws (4x). Remove the cover.

4. Place the hard drive over one of the sets of screw slots on the bottom of the system and then slide the hard drive into place. The SATA connectors on the hard drive should face the center of the unit.

5. Turn the system over carefully. Tighten the hard drive screws (4x) to secure the hard drive.

6. Connect the SATA power and data cable to the hard drive.
7. Replace the cover and cover screws (4x).

<table>
<thead>
<tr>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>After installation, you must format the hard drive in order to use it with the system. See 20.3 Formatting Hard Drives, page 161.</td>
</tr>
</tbody>
</table>

20.2 Removing the Hard Drive

20.2.1 LHV2104 / LHV2108 / LHV2116

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make sure that the system is OFF and ALL power adapters have been disconnected before removing/installing the hard drive.</td>
</tr>
</tbody>
</table>

1. Power off the system, and unplug all cabling from the system.
2. Remove the rear panel screws (4x) and side panel screws (1x on each side). Remove the cover.
3. Turn the system over and loosen the hard drive screws (4x), but do not remove them.
4. Disconnect the SATA power and data cable from the hard drive.
5. Carefully turn the system over. Slide the hard drive and then lift it out of the system.

6. Replace the cover and cover screws (6x).

**NOTE**
After installation, you must format the hard drive in order to use it with the system. See 20.3 Formatting Hard Drives, page 161.

20.2.2 LHV2216

**CAUTION**

Make sure that the system is OFF and ALL power adapters have been disconnected before removing/installing the hard drive.

1. Power off the system, and unplug all cabling from the system.
2. Remove the rear panel screws (4x). Remove the cover.
3. Turn the system over and loosen the hard drive screws (4x), but do not remove them.
4. Disconnect the SATA power and data cable from the hard drive.

5. Carefully turn the system over. Slide the hard drive and then lift it out of the system.

6. Replace the cover and cover screws (4x).

NOTE
After installation, you must format the hard drive in order to use it with the system. See 20.3 Formatting Hard Drives, page 161.

20.3 Formatting Hard Drives
You must format hard drives before you may use them with the system.

CAUTION
Formatting the HDD erases all data on the hard disk. This step cannot be undone. System settings will not be erased.

To format the hard drive:
1. From the Main Menu, click [X] and then click **Storage>HDD Manager**.

2. Select the hard drive you would like to format and then click **Format**. Click **OK** to confirm.

3. Click **OK** to save changes. The system will restart to complete the formatting process.
Connecting a PTZ Camera (LHV2000 Series)

You can connect PTZ cameras (not included) to the system. You can use 1080p MPX, 720p HD, and analog PTZ cameras with the system. Lorex MPX PTZ cameras can accept PTZ commands directly through the video cable. Lorex 1080p MPX and 720p HD PTZ cameras do not require wiring for RS485.

To connect a PTZ camera to the system:

• Connect the camera video cable to one of the Video IN ports on the system. If you have an 1080p MPX or 720p HD PTZ camera, it will automatically be detected and can be controlled by the DVR.

If you have an analog PTZ camera, connect the RS485 wires for analog PTZ cameras to the AB ports on the rear panel of the DVR. A is positive (+) and B is negative (-).

1. BNC Video Cable: Used with all types of cameras.
2. RS485: Used with analog cameras only.
   • A (TX+)
   • B (TX-)
3. PTZ Camera

If you have an analog PTZ camera, you must follow the steps below to configure the DVR to communicate with the camera:

1. Right-click and click Main Menu. Enter the system user name (default: admin) and password (default: 000000) if prompted.

2. Click Setting>Pan/Tilt/Zoom.
Connecting a PTZ Camera (LHV2000 Series)

3. Under **Channel**, select the channel your PTZ camera is connected to.
4. Under **Control Mode**, select **Serial**. Configure the following settings for your PTZ camera.

<table>
<thead>
<tr>
<th>NOTE</th>
<th>See the instruction manual for your PTZ camera for details on how to find the information below.</th>
</tr>
</thead>
</table>

- **Protocol**: Select the camera’s PTZ protocol (for example, Pelco P).
- **Address**: Enter your PTZ camera’s address.
- **Baud Rate**: Enter the baud rate for your PTZ camera.
- **Data Bits**: Enter your PTZ camera’s data bit setting.
- **Stop Bit**: Enter your PTZ camera’s stop bit setting.
- **Parity**: Enter your PTZ camera’s parity setting.

5. Click **OK**. You can now control your PTZ camera using the system.

### 21.1 Controlling a PTZ Camera (Local DVR)

1. In Live View, double-click the channel that has the PTZ camera connected to open in full-screen.
2. Right-click and click **Pan/Tilt/Zoom**. Enter the system user name and password if prompted. The PTZ menu opens.
3. Use the on-screen PTZ controls to control the camera.

#### PTZ Controls

1. **Direction keys**: Click to pan and tilt the camera. Click **SIT** to stop the current action.
2. **Mouse PTZ**: Click to activate mouse PTZ mode. In mouse PTZ mode:
   - Click and drag to move the camera.
   - Use the scroll wheel to zoom in and out.
   - Right-click to exit and return to normal PTZ controls.
3. **Zoom/Focus/Iris**: Click +/- to adjust the zoom, focus, and iris.
4. **Advanced controls**: Click to open advanced PTZ controls.
5. **Speed**: Enter the PTZ speed.

### 21.2 Advanced PTZ Controls

Advanced PTZ controls can be used to save camera positions and cycle through various positions, and automate camera actions.

**To open advanced PTZ controls:**

- Click the arrow in the PTZ control window to open advanced controls.
Connecting a PTZ Camera (LHV2000 Series)

1. **No.**: Select the number of the action you want to perform.
2. **Not supported**.
3. **PTZ camera menu**: Click to open the camera’s OSD menu. This may not be supported on all camera models.
4. **Preset**: Click to call the selected preset.
5. **Autopan**: Click to start autopan. During autopan, the camera will continuously pan 360°.
6. **Tour**: Click to run the selected tour.
7. **Flip**: Click to flip the camera 180°.
8. **Pattern**: Click to run the selected pattern.
9. **Reset**: Click to move the camera to the home position.
10. **Auto scan**: Click to run the selected autoscan.
11. **Aux**: Click to open the aux menu, where you can set up Presets, Tours, Patterns, and Auto Scans.

### 21.2.1 Presets

Presets will save a camera position for quick retrieval.

**To add presets:**

1. Click to open the aux menu.
2. Click the Preset tab.
3. Enter the number of the preset you want to create under **Preset**.
4. Move the camera to the desired position and click **Set**.

**To go to a preset:**

- Under **No.**, select the number of the preset you would like to go to and click 📅.

### 21.2.2 Tours

Tours will cycle through a set of presets.

**To create a tour:**

1. Click 📅 to open the aux menu.
2. Click the **Tour** tab.
3. Under **Patrol No.**, select the tour you would like to configure.
4. Under **Preset**, select a preset you would like to add to the tour.
5. Click **Add Preset**.
6. Repeat steps 4 and 5 to add additional presets to the tour.

**NOTE**

Click **Del Tour** to clear all presets from a tour.

**To run a tour:**

- Under **No.**, select the number of the tour you would like to go to and click 📅.

### 21.2.3 Pattern

Patterns automatically cycle the camera between two positions.

**To create a pattern:**

1. Click 📅 to open the aux menu.
2. Click the **Pattern** tab.
3. Under **Pattern**, enter the pattern you would like to configure.
4. Move the camera into the desired start position and click **Begin**.
5. Move the camera into the desired end position and click **End**.

**To run a pattern:**

- Under **No.**, select the number of the pattern you would like to go to and click 📊.

### 21.2.4 Auto Scan

An auto scan automatically cycles between a left and right point.

**To create a new auto scan:**

1. Click 📊 to open the aux menu.
2. Click the **Border** tab.

![Border tab](image)

3. Move the camera into the desired left position and click **Left**.
4. Move the camera into the desired right position and click **Right**.

**To run an auto scan:**

- Click 📊.
Recording Audio

The system supports one channel of audio recording. You must connect a self-powered microphone (not included).

**NOTE**
Audio recording without consent is illegal in certain jurisdictions. Lorex Corporation assumes no liability for use of its products that does not confirm with local laws.

### 22.1 Step 1 of 2: Connecting a Self-powered Microphone

1. Only channel 1 can be set to record audio from a self-powered microphone. Connect the camera that will be near the microphone to channel 1.
2. Connect the microphone to the **Audio IN** (RCA) port on the system.
3. Connect a speaker to the **Audio OUT** (RCA) port on the system. If you are using an HDMI TV or monitor with speakers, the HDMI cable will output audio to the speakers on the monitor.

**NOTE**
External microphones and speakers have a power source. They cannot draw power from the audio cables.

![Diagram of audio connections](image)

1. Microphone
2. Speaker
3. Video Cable
4. Camera

### 22.2 Step 2 of 2: Configuring Audio Recording

1. Right-click and click **Main Menu**. Enter the system user name (default: admin) and password (default: 000000) if prompted.
2. Click and select Recording > Recording.

3. Under Channel, select the channel where the audio-capable camera is connected.
4. Under Audio/Video, check the box on the left to enable audio recording.
5. Under Audio Encode, select the format that will be used to record audio. G711a is recommended.
6. Click OK to save changes.
When a malfunction occurs, it may not be serious and can be corrected easily. The following describes the most common problems and solutions. Please refer to the following before calling Lorex Technical Support:

<table>
<thead>
<tr>
<th>Error</th>
<th>Possible Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| • System is not receiving power, or is not powering up. | • Cable from power adapter is loose or is unplugged. | • Confirm that all cables are connected correctly.  
• Confirm that the power adapter is securely connected to the back of the unit. |
| • Power switch is set to OFF ( ) position. | | • Confirm that the power switch is in the ON (I) position. |
| • Cables are connected, but system is not receiving sufficient power. | | • Confirm that the system is powered on (LED indicators on the front should be ON).  
• If the unit is connected through a power bar or surge protector, try bypassing the bar and connecting the power directly to the wall outlet.  
• Confirm that there is power at the outlet:  
• Connect the power cable to another outlet.  
• Test the outlet with another device (such as a lamp or phone charger). |
| • Remote control is not detected by the system. | • Battery in the remote control is drained.  
• There are no batteries in the remote control. | • Install two fresh AAA alkaline batteries in the remote control. |
| • Hard drive is not detected by the system. | • Hard drive cables are loose or not properly connected. | • Remove the housing and check that hard drive cables are firmly connected.  
• There is no hard drive in the system.  
• Open the housing and install compatible hard drive. Make sure to format the drive after installing. For details, see 20 LHV2000 Series Hard Drive Installation, page 156. |
<p>| • Hard drive is full (0%) and the unit is no longer recording. | • Overwrite is not enabled. | • From the Main Menu, select &gt;Setting&gt;General&gt;General. Select Overwrite under HDD Full and click OK. |</p>
<table>
<thead>
<tr>
<th>Error</th>
<th>Possible Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>• There is no picture on monitor/TV after connecting it to the system.</td>
<td>• Monitor/TV not detected by system.</td>
<td>• Power off the monitor/TV and system. Power on the monitor/TV, and then power on the system.</td>
</tr>
<tr>
<td>• Input channel for system not selected on monitor/TV.</td>
<td>• On the monitor/TV, select the input channel the system is connected to.</td>
<td></td>
</tr>
<tr>
<td>• Video cable is loose or has become disconnected.</td>
<td>• Check the video cable connection to the system and monitor/TV.</td>
<td></td>
</tr>
<tr>
<td>• Mouse not detected by system.</td>
<td>• Mouse cable is not firmly connected to the system. Mouse is not connected to the system.</td>
<td>• Firmly connect the mouse cable to one of the USB ports.</td>
</tr>
<tr>
<td>• System needs to be reset</td>
<td></td>
<td>• Power off the system (disconnect power cable). Firmly connect a USB mouse to one of the USB ports. Reconnect the power cable to the DC 12V port on the rear panel.</td>
</tr>
<tr>
<td>• There is no picture on selected channels / camera picture is not being displayed.</td>
<td>• Camera cables are loose or have become disconnected.</td>
<td>• Check the camera video cable and connections. • Disconnect and reconnect the cable at the system and at the camera. • Try moving the camera to another channel or use another cable.</td>
</tr>
<tr>
<td>• The system beeps at startup.</td>
<td></td>
<td>• The beep at startup is normal.</td>
</tr>
<tr>
<td>• The system beeps during motion detection.</td>
<td>• Motion detection is enabled and the alarm buzzer is activated.</td>
<td>• Open the Main Menu and click &gt; Event &gt; Motion &gt; Motion Detect. Uncheck Buzzer for each channel and click Apply.</td>
</tr>
<tr>
<td>• I am not receiving email notifications.</td>
<td>• Email notification is disabled.</td>
<td>• Ensure you have configured email notification. For details, see 15.3.5 Configuring Email Alerts, page 54.</td>
</tr>
<tr>
<td></td>
<td>• Send Email setting not enabled in Event menu.</td>
<td>• Make sure that Send Email is enabled for any events you want to be notified of.</td>
</tr>
</tbody>
</table>
## LHV2000 Series System Specifications

### System

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Linux (embedded)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pentaplex</td>
<td>Simultaneous view, record, playback, backup &amp; remote monitoring</td>
</tr>
<tr>
<td>Number of Channels</td>
<td>4/8/16-channel — 1080p MPX, 720p HD, or analog cameras supported</td>
</tr>
</tbody>
</table>

### Inputs/Outputs

<table>
<thead>
<tr>
<th>Video IN</th>
<th>4/8/16 x 1Vp-p, CVBS, 75ohms, BNC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video OUT</td>
<td>No</td>
</tr>
<tr>
<td>VGA OUT</td>
<td>Yes</td>
</tr>
<tr>
<td>HDMI</td>
<td>Yes</td>
</tr>
<tr>
<td>Audio IN</td>
<td>1 Line in (RCA)</td>
</tr>
<tr>
<td>Audio OUT</td>
<td>1 Line out (RCA)</td>
</tr>
<tr>
<td>USB Port</td>
<td>1 at the back, 1 at the front</td>
</tr>
<tr>
<td>Alarm IN</td>
<td>None</td>
</tr>
<tr>
<td>Alarm OUT</td>
<td>None</td>
</tr>
<tr>
<td>Video Output Resolution</td>
<td>1920x1080 (HDMI), 1280x1024, 1024x768</td>
</tr>
<tr>
<td>PTZ Control</td>
<td>RS-485 Pelco D &amp; P Protocol</td>
</tr>
</tbody>
</table>

### Display

<table>
<thead>
<tr>
<th>Live Display</th>
<th>4 ch: 1, 4 8 ch: 1, 4, 8 16 ch: 1, 4, 8, 9, 16</th>
</tr>
</thead>
<tbody>
<tr>
<td>Live Display Speed</td>
<td>4 ch: 120 NTSC, 100 PAL 8 ch: 240 NTSC, 200 PAL 16 ch: 480 NTSC, 400 PAL</td>
</tr>
<tr>
<td>OSD</td>
<td>ON/OFF</td>
</tr>
<tr>
<td>System Navigation</td>
<td>USB mouse, IR remote controller, front panel</td>
</tr>
<tr>
<td>Motion Area Setting</td>
<td>Adjustable grid (22x18)</td>
</tr>
<tr>
<td>Sensitivity Levels</td>
<td>100</td>
</tr>
<tr>
<td>Firmware Upgrade</td>
<td>Automatic over the Internet &amp; via USB device and network</td>
</tr>
<tr>
<td>User Authority</td>
<td>By user group</td>
</tr>
<tr>
<td>Time Synchronization</td>
<td>Auto time sync by NTP server</td>
</tr>
</tbody>
</table>

### Recording

<table>
<thead>
<tr>
<th>Video Compression</th>
<th>H.264</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Compression</td>
<td>G.711</td>
</tr>
</tbody>
</table>
| Recording Resolution      | **NTSC**: 1080p (1920x1080), 720p (1280x720), 960x480, 704x480, 352X480, 704x240, 352x240  
**PAL**: 1080p (1920x1080), 720p (1280x720), 960x576, 704x576, 352x288 |

#LX400060; r. 1.0/24102/24107; en-US 172
### Recording Frame Rate

<table>
<thead>
<tr>
<th>NTSC:</th>
<th>PAL:</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 ch:</td>
<td>4 ch:</td>
</tr>
<tr>
<td>60fps @ 1080p / 120fps @ 720p</td>
<td>48fps @ 1080p / 100fps @ 720p</td>
</tr>
<tr>
<td>8 ch:</td>
<td>8 ch:</td>
</tr>
<tr>
<td>120fps @ 1080p / 240fps @ 720p</td>
<td>96fps @ 1080p / 200fps @ 720p</td>
</tr>
<tr>
<td>16 ch:</td>
<td>16 ch:</td>
</tr>
<tr>
<td>240fps @ 1080p / 480fps @ 720p</td>
<td>192fps @ 1080p / 400fps @ 720p</td>
</tr>
</tbody>
</table>

### Recording Resolution Setting
- Per camera for different resolutions

### Recording Quality Control
- 6 levels

### Recording Schedule
- By hour, by day, by recording mode, by motion, by channel

### Pre Recording
- Max. 30 Seconds

### Post Recording
- Max. 5 Minutes

### Reliability
- Watch-Dog, auto-recovery after power failure

### Covert Video
- Yes

### Playback

<table>
<thead>
<tr>
<th>Playback Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 ch 1 / 4</td>
</tr>
<tr>
<td>8 ch: 1 / 4 / 8</td>
</tr>
<tr>
<td>16 ch: 1 / 4 / 9 / 16</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Playback Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable Max 4x</td>
</tr>
</tbody>
</table>

### Playback Players
- Backup Player

### Search
- By time & event

### Log Search
- Up to 1,000 lines for motion detected, configuration changes, connects/disconnects and video loss

### Audio Play
- Yes

### Storage & Archive

<table>
<thead>
<tr>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>LHV2104 / LHV2108 / LHV2116: Up to 1 HDD’s (SATA)</td>
</tr>
<tr>
<td>LHV2216: Up to 2 HDD’s (SATA)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>LHV2104 / LHV2108 / LHV2116: Up to 1x4TB</td>
</tr>
<tr>
<td>LHV2216: Up to 2x4TB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Backup Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB flash drive &amp; HDD</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Backup File Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAV or ASF file</td>
</tr>
</tbody>
</table>

### Connectivity

<table>
<thead>
<tr>
<th>Cloud Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLIR Cloud™</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Supported Operating Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows™, Mac OSX</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Remote Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Software (PC/Mac)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Email Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text with snapshot</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Instant Smart Phone &amp; Tablet Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>iPad®, iPhone®, Android™</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DDNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free Lorex DDNS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full setup configuration over network</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programmable by User</td>
</tr>
</tbody>
</table>
Network Protocol
HTTP, IPv4/IPv6, TCP/IP, UPNP, RTP, UDP, SMTP, NTP, DHCP, DNS, PPPOE, DDNS, FTP, IP Filter

Network Interface
10/100-Base-TX, RJ-45

Network Speed Control
48Kb ~ 4096Kb/sec. per camera

General

Power Consumption
Approx. 10 watts (No HDD Installed)

Supply Voltage
LHV2104 / LHV2108: 100VAC-240VAC, 12VDC, 2A, 50/60Hz
LHV2116: 100VAC-240VAC, 12VDC, 3A, 50/60Hz
LHV2216: 100VAC-240VAC, 12VDC, 5A, 50/60Hz

Unit Dimensions (W x D x H)
LHV2104 / LHV2108 / LHV2116: 12.8” x 10.0” x 2.2”
325mm x 255mm x 55mm
LHV2216: 14.8” x 11.5” x 1.8”
375mm x 292mm x 46mm

Unit Weight
LHV2104 / LHV2108 / LHV2116: 3.3lbs / 1.5kg
LHV2216: 3.9lbs / 1.8kg

Operating Temperature
32° ~ 104° F / 0° ~ 40° C

Humidity
10 ~ 90% RH

Recording Resolution (Pixels) & Speed (FPS - Frames per second)

<table>
<thead>
<tr>
<th>Model</th>
<th>FPS (NTSC/PAL)</th>
<th>720p</th>
<th>1280x720</th>
<th>1080p</th>
<th>1920x1080</th>
</tr>
</thead>
<tbody>
<tr>
<td>LHV2104</td>
<td>Total</td>
<td>120/100</td>
<td>60/48</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Per channel</td>
<td>30/25</td>
<td>15/12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LHV2108</td>
<td>Total</td>
<td>240/200</td>
<td>120/96</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Per channel</td>
<td>30/25</td>
<td>15/12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LHV2116 / LHV2216</td>
<td>Total</td>
<td>480/400</td>
<td>240/192</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Per channel</td>
<td>30/25</td>
<td>15/12</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

As our products are subject to continuous improvement, Lorex Corporation and its subsidiaries reserve the right to modify product design, specifications, and prices without notice and without incurring any obligation. E&OE
This product has been certified and found to comply with the limits regulated by FCC, EMC, and LVD. Therefore, it is designated to provide reasonable protection against interference and will not cause interference with other appliance usage. However, it is imperative that the user follows the guidelines in this manual to avoid improper usage, which may result in damage to the product, electrical shock and fire hazard injury.

25.1 FCC/IC Notice

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception (which can be determined by turning the equipment on and off), the user is encouraged to try to correct the interference by one or more of the following measures:

1. Reorient or relocate the receiving antenna.
2. Increase the separation between the equipment and receiver.
3. Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
4. Consult the dealer or an experienced radio or television technician for assistance.

25.2 Modification

Any changes or modifications not expressly approved by the grantee of this device could void the user's authority to operate the device.

Toute modification non approuvée explicitement par le fournisseur de licence de l'appareil peut entraîner l'annulation du droit de l'utilisateur à utiliser l'appareil.

25.3 ROHS

This product is fully compliant with the European Union Restriction of the Use of Certain Hazardous Substances in Electrical and Electronic Equipment ("RoHS") Directive (2002/95/EC). The RoHS directive prohibits the sale of electronic equipment containing certain hazardous substances such as lead, cadmium, mercury, and hexavalent chromium, PBB, and PBDE in the European Union.